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The Imperx Cheetah CMOS cameras provide exceptional video image quality in a 
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cameras use Sony 3rd generation Pregius CMOS sensors for their high sensitivity, image 
clarity, and high dynamic range. They achieve frame rates up to 56.5 frames per second 
with 10 GigE Vision interface. An SFP+ connector is provided to mate with various 
transceiver modules 
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About Imperx, Inc. 
IMPERX, Inc. is a leading designer and manufacturer of high performance, high quality digital 
cameras, frame grabbers, and accessories for industrial, commercial, military, and aerospace 
imaging applications including flat panel inspection, biometrics, aerial mapping, surveillance, 
traffic management, semiconductors and electronics, scientific & medical Imaging, printing, 
homeland security, space exploration, and other imaging and machine vision applications.  
 

Fortune 100 companies, federal and state government agencies, domestic and foreign defense 
agencies, academic institutions, and other customers worldwide use IMPERX products. 
 

Imperx, Inc. | 6421 Congress Ave. | Boca Raton, FL, 33487 

US Phone: +1 (561) 989-0006 
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Warranty 
 

IMPERX warrants performance of its products and related software to the specifications 
applicable at the time of sale in accordance with IMPERX’s standard warranty, which is 2 (two) 
years parts and labor.  
 

Do not open the housing of the camera. Warranty voids if the housing has been open or 
tampered. 
 
IMPORTANT NOTICE 

This camera has been tested and complies with the limits of Class A digital device, pursuant to 
part 15 of the FCC rules. 
 

Copyright © 2020, 2021 IMPERX Inc. All rights reserved. All information provided in this manual 
is believed to be accurate and reliable. No responsibility is assumed by IMPERX for its use. 
IMPERX reserves the right to make changes to this information without notice. Redistribution of 
this manual in whole or in part, by any means, is prohibited without obtaining prior permission 
from IMPERX. IMPERX reserves the right to make changes to its products or to discontinue any 
product or service without notice and advises its customers to obtain the latest version of 
relevant information to verify, before placing orders, that the information being relied on is 
current. 
 
 

IMPERX PRODUCTS ARE NOT DESIGNED, INTENDED, AUTHORIZED, OR WARRANTED TO BE 
SUITABLE FOR USE IN LIFE-SUPPORT APPLICATIONS, DEVICES OR SYSTEMS OR OTHER CRITICAL 
APPLICATIONS, WHERE MALFUNCTION OF THESE PRODUCTS CAN REASONABLY BE EXPECTED TO 
RESULT IN PERSONAL INJURY. IMPERX CUSTOMERS USING OR SELLING THESE PRODUCTS FOR 
USE IN SUCH APPLICATIONS DO SO AT THEIR OWN RISK AND AGREE TO FULLY INDEMNIFY 
IMPERX FOR ANY DAMAGES RESULTING FROM SUCH IMPROPER USE OR SALE. 
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REVISION HISTORY 
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to 8164 
Changed Operating Temperature Range 
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Histogram, Camera Terminal, HexPixelDump 
Added Saving Image in AVI Movie File Format 
section 
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Updated Canon Lens Control specifications 
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TERMINOLOGY 

Defective pixels – these are pixels whose sensitivity deviates due to fluctuations in the CMOS 
manufacturing process and materials. 

Fast trigger mode – a camera exposes a frame and then exposes the next frame while reading 
out the previous frame. In this way, the camera overlaps the exposure and readout times. Fast 
trigger mode requires a predictable and stable trigger period. The TriggerOverlap setting is On. 

Free-running mode – a camera runs without synchronization to an external trigger pulse 
(untriggered mode).  

Hot pixels – these are pixels that in normal camera operation behave as normal pixels (sensitivity 
equal to one of the adjacent pixels). But during long exposures or at elevated temperatures, the 
pixel becomes far brighter than the average of the pixels surrounding it. In some cases, the pixel 
becomes so bright that it saturates. 

Standard trigger mode – a camera waits for a trigger pulse, then exposes using an internal 
exposure timer and reads out a frame and waits for next trigger pulse. The exposure and readout 
do not overlap. The TriggerOverlap setting is Off.  

Trigger mode – a camera waits for a trigger pulse to start the image capture, synchronizing it to 
either an internal or external event. 

AEC – Automatic exposure control 

AGC – Automatic gain control 

AOI – Area of interest 

AWB – Automatic white balance 

DPC – Defective pixel correction 

FFC – Flat field correction 

HPC – Hot pixel correction 

LUT – Look-up table 

SFP – Small Form-factor Pluggable 
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About the Camera 

General 
The 10 GigE Vision SFP+ Cheetah CMOS cameras are built around advanced Sony Pregius CMOS 
image sensors with global shutter for high quality images in a small ruggedized form factor. 
Cheetah cameras are progressive scan digital cameras featuring a built-in image-processing 
engine, low power consumption, low noise, high dynamic range (71 dB), and fast frame rates for 
high throughput applications.  

The cameras provide several trigger modes and output strobes allowing you to synchronize the 
image capture of one or more cameras to an external event. You can vary exposure times using 
internal controls or an external pulse width.  

The cameras also provide an area of interest (AOI), programmable look-up tables (LUT) and the 
ability to store up to four different camera configurations. Using the simple GenICam™ compliant 
user interface, you can quickly change the camera configuration. User-defined LUT capabilities 
optimize the cameras’ dynamic range. Hot and defective pixel correction is available to correct 
over-responding or under-responding pixels.  

The cameras are suitable for a wide range of environmental conditions and applications, such as 
machine vision, industrial inspection, surveillance, aerospace, and more. 

The C5440, C4440, and C6440 cameras feature 17 MP, 20 MP, and 31 MP Sony Pregius CMOS 
sensors respectively, provide support for active Canon EOS lens with iris and focus controls. 
 
Camera Model Resolution 

(MP) 
Resolution 
(H x V) 

Frame 
Rate 
(Max) 

Type 
(Color/ 
Mono) 

Optical 
format 

Pixel Size 
(microns) 

Sony Sensor 
Model 

SFP-C5440 17 5472 x 3084 56.5 C, M 4/3” 3.45 IMX387 

SFP-C4440 20 4416 x 4436 39.6 C, M 4/3” 3.45 IMX367 

SFP-C6440 31 6464 x 4860 35.4 C, M APS-C 3.45 IMX342 
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Key Features 
• Global shutter (GS) 

• Color and monochrome versions 

• Fast frame rates 

• High data transfer rates up to 10 Gbit/s 

• Internal and external exposure controls 

• Automatic exposure and gain control (AEC/AGC) 

• Analog and digital gain control 

• Offset control 

• Built-in pulse generator 

• Area of interest (AOI) 

• Programmable external inputs and outputs 

• Multiple Trigger/Synchronization options 

• Automatic white balance 

• Four 12-bit look-up tables (LUT) 

• Hot and defective pixel correction, user-defined and factory 

• Eight flat field correction tables, user-defined and factory 

• Dynamic transfer function  

• Canon EOS EF lens control 

• Forced air cooling  

• Temperature monitor 

• Field upgradeable firmware 
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Technical Specifications 

SFP-C5440 Camera Specifications 
Specifications SFP-C5440 (17 MP) 
Active image resolution  5472 (H) x 3084 (V) 
Pixel size  3.45 µm 
Optical format 4/3 inch 
Shutter Global 
Frame rate (max) 56.5 fps (8-bit), 34.7 (10, 12-bit unpacked), 40.4 (10, 12-bit packed) 
Sensor digitization  10 or 12-bit 
Dynamic range 71 dB 
Output bit depth 8, 10, or 12-bit 
Shutter speed  36 µs to 16.0 s 
Analog / Digital gain  Manual, auto, once; 0–48 dB (0.1 dB step) 
Digital gain 1x (0 dB) to 4x (12 dB), 0.001x step 
AEC/AGC  Off, once, auto 
Black level offset  Manual (0–4095), auto 
Exposure control Manual, auto, once, external, off 
White balance Manual, auto, once, off 
Area of Interest (AOI) One 
Binning 1x2, 2x1, 2x2 (available only for monochrome sensors) 
Sub-sampling decimation 1x2, 2x1, 2x2 
Trigger inputs External, pulse generator, software 
Trigger options Edge, pulse width, trigger filter, trigger delay, debounce 
Trigger modes Free-run, standard, fast 
I/O control 2 IN (OPTO, LVTTL) / 2 OUT (OPTO, TTL) 
Strobe output  2 strobes, programmable position and duration 
Pulse generator Yes, programmable 
Data correction 2 LUTs pre-programmed with Gamma 0.45,  

2 LUTs pre-programmed with Negative LUT; 
Hot and Defective pixel correction (static); 8 Flat field correction tables 

Lens mount F-mount (default), Canon EOS active or passive, M42 (optional) 
Camera housing 6000 series aluminum 
Upgradeable firmware Yes 
Forced Air Cooling Control On, off, auto 
Supply voltage range 12 VDC (6.5 V–33 V), 2 A inrush @ 12 V 
Power consumption Typ.: 14.4 W;    Max.: 16.8 W  
Camera size (W x H x L) 60 mm x 60 mm x 99 mm 
Weight 530 g 
Vibration, shock 20G (20–200 Hz XYZ) / 100G 

Environmental 

Operating 
 
 
Storage 

-30 °C to +70 °C (with a fiber 10GBase-R transceiver module); 
(may vary depending on the transceiver module used);  

-30 °C to +45 °C (with a copper 10GBase-T transceiver module) 
-40 °C to +85 °C 

Relative humidity 10% to 90% non-condensing 
Regulatory FCC part 15 Class A, CE, RoHS, UKCA 
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SFP-C4440 Camera Specifications 
Specifications SFP-C4440 (20 MP) 

Active image resolution  4416 (H) x 4436 (V) 
Pixel size  3.45 µm 
Optical format 4/3 inch 
Shutter Global 
Frame rate (max) 39.6 fps (8-bit), 28.3 (10, 12-bit unpacked), 28.3 (10, 12-bit packed) 
Sensor digitization  10 or 12-bit 
Dynamic range 71 dB 
Output bit depth 8, 10, or 12-bit 
Shutter speed  36 µs to 16.0 s 
Analog / Digital gain  Manual, auto, once; 0–48 dB (0.1 dB step) 
Digital gain 1x (0 dB) to 4x (12 dB), 0.001x step 
AEC/AGC  Off, once, auto 
Black level offset  Manual (0–4095), auto 
Exposure control Manual, auto, once, external, off 
White balance Manual, auto, once, off 
Area of Interest (AOI) One 
Binning 1x2, 2x1, 2x2 (available only for monochrome sensors) 
Sub-sampling decimation 1x2, 2x1, 2x2 
Trigger inputs External, pulse generator, software 
Trigger options Edge, pulse width, trigger filter, trigger delay, debounce 
Trigger modes Free-run, standard, fast 
I/O control 2 IN (OPTO, LVTTL) / 2 OUT (OPTO, TTL) 
Strobe output  2 strobes, programmable position and duration 
Pulse generator Yes, programmable 
Data correction 2 LUTs pre-programmed with Gamma 0.45,  

2 LUTs pre-programmed with Negative LUT; 
Hot and Defective pixel correction (static);  
8 Flat field correction tables 

Lens mount F-mount (default), Canon EOS active or passive, M42 (optional) 
Camera housing 6000 series aluminum 
Upgradeable firmware Yes 
Forced Air Cooling Control On, off, auto 
Supply voltage range 12 VDC (6.5 V–33 V), 2 A inrush @ 12 V 
Power consumption Typ.: 14.4 W ;    Max.: 16.8 W  
Camera size (W x H x L) 60 mm x 60 mm x 99 mm 
Weight 530 g 
Vibration, shock 20G (20–200 Hz XYZ) / 100G 

Environmental 

Operating 
 
 
Storage 

-30 °C to +70 °C (with a fiber 10GBase-R transceiver module); 
(may vary depending on the transceiver module used); 

-30 °C to +45 °C (with a copper 10GBase-T transceiver module) 
-40 °C to +85 °C 

Relative humidity 10% to 90% non-condensing 
Regulatory FCC part 15 Class A, CE, RoHS, UKCA 
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SFP-C6440 Camera Specifications 
Specifications SFP-C6440 (31 MP) 

Active image resolution  6464 (H) x 4860 (V) 
Pixel size  3.45 µm 
Optical format APS-C 
Shutter Global 
Frame rate (max) 35.4 fps (8-bit), 25.8 fps (10, 12-bit packed) 
Sensor digitization  10 or 12-bit 
Dynamic range 71 dB 
Output bit depth 8, 10, or 12-bit 
Shutter speed  36 µs to 16.0 s 
Analog / Digital gain  Manual, auto, once; 0–48 dB (0.1 dB step) 
Digital gain 1x (0 dB) to 4x (12 dB), 0.001x step 
AEC/AGC  Off, once, auto 
Black level offset  Manual (0–4095), auto 
Exposure control Manual, auto, once, external, off 
White balance Manual, auto, once, off 
Area of Interest (AOI) One 
Binning 1x2, 2x1, 2x2 (available only for monochrome sensors) 
Sub-sampling decimation 1x2, 2x1, 2x2 
Trigger Inputs External, pulse generator, software 
Trigger options Edge, pulse width, trigger filter, trigger delay, debounce  
Trigger modes Free-run, standard, fast 
I/O control 2 IN (OPTO, LVTTL) / 2 OUT (OPTO, TTL) 
Strobe output  2 strobes, programmable position and duration 
Pulse generator Yes, programmable 
Data correction 2 LUTs pre-programmed with Gamma 0.45,  

2 LUTs pre-programmed with Negative LUT; 
Hot and Defective pixel correction (static);  
8 Flat field correction tables 

Lens mount F-mount (default), Active or passive Canon EOS, M42 (optional) 
Camera housing 6000 series aluminum 
Upgradeable firmware Yes 
Forced Air Cooling Control On, off, auto 
Supply voltage range 12 VDC (6.5 V–33 V), 2 A inrush @ 12 V 
Power consumption Typ. : 14.4 W;  

Max. : 16.8 W 
Camera size (W x H x L) 60 mm x 60 mm x 99 mm 
Weight 530 g 
Vibration, shock 20G (20–200 Hz XYZ) / 100G 

Environmental 

Operating 
 
 
Storage 

-30 °C to +70 °C (with a fiber 10GBase-R transceiver module); 
(may vary depending on the transceiver module used 

-30 °C to +45 °C (with a copper 10GBase-T transceiver module); 
-40 °C to +85 °C 

Relative humidity 10% to 90% non-condensing 
Regulatory FCC part 15 Class A, CE, RoHS, UKCA 
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Ordering Information 
When ordering a camera, please specify the camera ordering code. To create your own customer 
Cheetah ordering code, simply choose one element from each column: 

Interface Camera model Sensor Type Ruggedized  Lens Mount 
Filter/custo
mization 
options 

SFP =  
10 GigE Vision 
with SFP+ 
connector 

C5440 – 5472 x 3084 
C4440 – 4416 x 4436 
C6440 – 6464 x 4860  

C = Color 
M = Monochrome 

R= Ruggedized F= F-Mount 
M = M42 
L= Canon EF EOS 
Active Mount 
E = Canon EF EOS 
Passive Mount 

000 = none 

• 000 (none) filter/customization option means that a color camera has an IR-cut filter, while a 
monochrome camera does not have any filters. 

• Sample codes:  
SFP-C6440M-RF000: Cheetah Monochrome 31 MP camera with F-Mount and 10 GigE Vision with 
SFP+ connector. 
SFP-C5440C-RL000: Cheetah Color 17 MP camera with Canon EF EOS Active Mount and 10 GigE 
Vision with SFP+ connector 

• An external power supply is required. 

• The Imperx PS12V04A power supply is available for use with SFP cameras and can be purchased 
separately. 

Accessories 
Imperx offers a power supply for use with the cameras. The power supply is sold separately.  
 

Part Number Description Compatible with: 

PS12V14A Standard Power Supply 
12 V DC, 3 A, 
With one strobe and one trigger, 
1.75 m length 

SFP-C4440 
SFP-C5440 
SFP-C6440 
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Technical Support 
Each camera is fully tested before shipping. If, for some reason, the camera is not operational 
after power up, check the following: 
 
1. Check the power supply, Ethernet, and all I/O cables.  

Make sure that all the connectors are firmly attached. 
 

2. Check the status LED and verify that it is steady ON, if not – refer to the section Camera LED 
Status Indicator. 

 
3. Enable the test mode and verify that the communication between a computer and the 

camera is established.  
If the test pattern is not present, power off the camera, check all the cabling, frame grabber settings, 
and computer status.  

 
If you still have problems with the camera operation, contact technical support at: 

Email: support@imperx.com 
Toll Free 1 (866) 849-1662 or (+1) 561-989-0006 
Fax: (+1) 561-989-0045 
Visit our website: www.imperx.com 
 

mailto:support@imperx.com
http://www.imperx.com/


Cheetah Pregius Camera with 10 GigE Vision Interface – User Manual  

 May 6, 2021 Page 17 of 181  Rev 1.1 

Hardware 
This chapter contains the detailed information needed for the initial design-in process: 

• connector types, pin numbering and assignments 

• electrical connectivity and voltage requirements 

• mechanical drawings and cabling 

• optical and environmental information 

C4440, C5440, C6440 Cameras 
Connectivity 
The back panel of the camera provides all the connectors needed to operate and control the 
camera and an LED status indicator. 

 

 
The camera provides the following connectors: 

• an open SFP+ slot providing data, control, and serial interface. The SFP+ slot accepts a 
variety of transceiver modules, including Fiber 10GBase-R and copper 10GBase-T. 

• male 12-pin Hirose miniature locking receptacle #HR10A-10R-12PB(71) providing power 
input and I/O interface. Use a female Hirose miniature locking plug #HR10A-10P-12S(73) on 
the mating end of your I/O cable 

• a camera status LED indicator 

• USB type B programming/SPI connector for factory use only 

• the camera’s model and serial number 
 
The camera transmits serialized video data output and communications over the 10 Gigabit 
Ethernet interface with consistently low, predictable latencies. The network interface is 
compatible with IP/Ethernet networks operating at 10 gigabits per second. 

camera status LED 

12-pin connector for power and I/O interface 

connector for factory use 

two Ethernet Link Status LEDs 

open SFP+ slot 
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SFP Transceiver Module Options 
The camera’s open SFP+ slot accepts a variety of commercially available SFP transceiver 
modules, including Multi-mode and single mode fiber and 10GBase-T copper modules. 
 
SFP transceiver module SFP transceiver module 

part number 
Cable 
length 

Compatible SFP+ NIC (example) 

10GBase-R fiber module FS SFP-10GSR-85 
(10G SFP+ 850 nm) 

300 m Intel 82599EN Single-Port 10G SFP+ 
PCie 2.0 x8 

10GBase-T copper module Cisco SFP-10G-T-S 
Compatible 

30 m Intel X540-T1 10Gb, 
Intel X550-T1 10Gb, 
10Gtek 10Gb PCI-E 

 

10GBase-SR Multi-Mode Fiber Example 
Below is an example of a 10GBase-SR SFP+ 850 nm Multi-mode Fiber Transceiver module  
(p/# FS SFP-10GSR-85) with 300 m range compatible with the Imperx SFP camera. 

 
 
For optimal performance, Imperx recommends a 10G Network Interface Card with SFP+ slot. 
Imperx has tested and recommends the Intel 82599EN Single-Port 10G SFP+ PCie 2.0 x8, 
Ethernet Network Interface card shown below.  
 
Available for purchase; contact Imperx sales: sales@imperx.com or +1-561-989-0006. 
 

 
For a multi-mode fiber optic connection, both the Imperx SFP camera and the NIC card must 
have a 10GBase-SR SFP+ Multi-mode Fiber Transceiver installed like the one shown above. 

mailto:sales@imperx.com
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10GBase-T Copper Example 
Below is an example of a Cisco SFP-10G-T-S Compatible, 10GBase-T SFP+ Copper Transceiver 
with RJ-45 connector.  

 
 
Imperx recommends an Intel X540-T1 or X550-T1 10Gb NIC card or equivalent. For example, the 
10Gb PCI-E NIC Card with single copper RJ45 Port from 10Gtek as shown below. 
 

 
 
After installation of the 10GBase-T SFP+ Copper Transceiver, the SFP camera can be connected 
to any 10GigE compatible NIC or Server using standard LAN CAT-5 (CAT-5e) or CAT-6 cables. 
Shielded cables are recommended. The cable length can vary based on the SFP+ module 
transceiver. For example, the above transceiver is suitable for distances up to 30 m.  
 
To help clients achieve first iteration success, Imperx offers a variety of transceiver modules and 
a 10G SFP+ NIC card for sale which have been tested together. Contact Imperx sales department 
for more information: sales@imperx.com or +1-561-989-0006. 
  

mailto:sales@imperx.com
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Pin Assignments 
The 12-pin Hirose connector on the camera’s back panel is a male type miniature locking 
receptacle #HR10A-10R-12PB(71). 

  

 
 

Pin Signal Name Use 

1 12/24 VDC Return 12 or 24 VDC Main Power Return 

2 +12/24 VDC 12 or 24 VDC Main Power 

3 Reserved Reserved 

4 Reserved Reserved 

5 OUT2 RTN General Purpose Output 2, Contact 1 (Opto-isolated) 

6 OUT1 RTN General Purpose Output 1 Return (TTL) 

7 OUT1 General Purpose Output 1 (TTL) 

8 INPUT1 General Purpose Input 1 (Opto-isolated) 

9 INPUT2 General Purpose Input 2 (TTL/LVTTL) 

10 INPUT1 RTN General Purpose Input 1 Return (Opto-isolated) 

11 INPUT2 RTN General Purpose Input 2 Return (TTL/LVTTL) 

12 OUT2 General Purpose Output 2, Contact 2 (Opto-isolated) 
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Camera LED Status Indicator 
The camera has a red-green-yellow LED on the back panel of the camera. The following LED 
colors and light patterns indicate the camera status and mode of operation: 
 
LED Color Light Patterns Status Description 

  

Green steady ON Normal operation. You should see a normal image coming 
out of the camera 

Green blinking Trigger enabled 

  

Amber steady ON Test mode. You should see one of the test patterns. 
Amber blinks at ~0.5 Hz Camera is in AGC/AEC mode. In this mode, changing the 

shutter slider does not affect image luminance 
Amber blinks at ~2.0 Hz Camera receives an external synchronization pulse 

  

Red steady ON Communications or firmware load error 

Red blinks at ~2.0 Hz Power failure 

  /   
Green / Red blinks at ~1 Hz GigE Vision firmware error 

  
LED Off No power 

Ethernet LED Status Indicators 
Two LEDs on the camera’s back panel indicate Ethernet status. 
 
Ethernet Status Amber LED Green LED 

10 Gbps Link – No Activity Off Solid On 

10 Gbps Link – Activity Off Blinks 

5 Gbps Link – No Activity Solid On Solid On 

5 Gbps Link – Activity Blinks Blinks 

2.5 Gbps Link – No Activity Solid On Off 

2.5 Gbps Link – Activity Blinks Off 

1 Gbps Link – No Activity Blinks Off 

1 Gbps Link – Activity Blinks Off 

100 Mbps Link – Activity Off Blinks at 1Hz 

100 Mbps Link – No Activity Off Blinks at 1Hz 

10 Mbps Link – Activity Blinks at 1Hz Off 

10 Mbps Link – No Activity Blinks at 1Hz Off 
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Powering the Camera 
 

The maximum supply voltage must not exceed 33 V DC. 
 
 

Plug in the SFP module prior to powering the camera. 
 
Use an external power supply to power the camera.  
 
The external power supply should provide 6.5 V – 33 V DC with the inrush current 2 A @ 12 V. The 
power supply should terminate in a female HIROSE plug #HR10A-10P-12S(73). 

Imperx offers the PS12V14A Standard Power Supply adapter for use with the cameras. The 
PS12V14A power supply can be purchased separately. It ships with a power cable that 
terminates in a female HIROSE plug #HR10A-10P-12S(73). The PS12V14A includes connectors for 
trigger (black wire) and strobe (white wire). Refer to the section PS12V14A Standard Power 
Supply for more information. 
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PS12V14A Standard Power Supply 
A universal PS12V14A power adapter provides +12 V DC ± 5% and up to 3 A DC current. The 
operating input voltage range is 100 to 240 V AC.  
 
The PS12V14A power supply terminates in a female Hirose type miniature locking plug #HR10A-
10P-12S(73). It has two BNC pig-tail cables providing external trigger input (black) and strobe 
output (white) 
 
 

Imperx recommends using the PS12V14A power adapter 
for powering C4440, C5440, and C6440 cameras. 
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PS12V14A Power Supply Specifications 
Specifications Description 
Input  

Voltage 100–240 V AC 
Frequency 50–60 Hz 
Current 1 A max 
Inrush Current 70 A max / 230 V AC (cold start @ 25 °C, full load) 
Efficiency Eff (av) ≥ 87.4 % (at 115 V AC & 230 V AC) 

Eff ≥ 78.303 % (at 230V/50Hz input @10% load for CoC Tier2) 
  
Output  

Voltage 11.4 V to 12.6 V DC, 12 V DC nominal 
Current 3 A max 
Load Regulation  ± 5% 
Ripple & Noise 1% Vpp max for Output Voltage @ full load 
Total Power  36.0 W Max 

Protection  
Over-Voltage Protective (OVP) V out * 180% (max) 
Short-Circuit Protective (SCP) Automatic recovery after short circuit fault being removed 
Over Current Protection (OCP) I out * 200% (max) 

  
Safety, EMI and EMC Requirement  

Safety UL, CUL, GS, PSE, BSMI, CB, RCM, CCC, KC, LPS 
Dielectric Strength 10 mA max. cut off current 

 (1) Primary to Secondary:  3000 V AC for 1 minute 
 (2) Primary to Frame Ground:  1500 V AC for 1 minute 

Insulation Resistance (1) Primary to Secondary:  10 MOhm for 500 V DC 
 (2) Primary to Frame Ground: 10 MOhm for 500 V DC 
EMI Requirement CE, FCC Class B, Conduction and Radiation meet 
Leakage Current Less than 3.5 mA 
Grounding Test Resistance 0.1 Ohm max @ 32 A 

  

Environmental Operating 
Storage 

0 °C to +40 °C 
-20 °C to +80 °C 

Relative humidity Operating 
Storage 

20% to 80% non-condensing 
10% to 90% non-condensing 

Regulatory DoE VI, ErP (Lot 7), GEMS, NRCan, CEC, RoHS 
  
Cable Length  

Supplied AC power input cable (IEC) 1.8 m (6’) 
Power supply output (+12 V) 1.75 m (5’) ± 15 cm (6”), connector HIROSE #HR10A-10P-12S 
Strobe 12.5 cm (5”) ± 1 cm (0.4”) connector BNC male 
Trigger 10 cm (4”) ± 1 cm (0.4”) connector BNC male 
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Active Canon EF mount 
The Canon EF lens mount provides active lens control for C4440, C5440, and C6440 cameras. 

The cameras provide communication and power to the mount through an internal connector on 
the front of the camera. The connector eliminates the need for a special power supply and 
external cable between the camera and the Canon EF mount. 
 
 

 
 

                
 
 
 
 
 

  

camera 
(front) Canon EF lens mount 

(back) 

internal connector 

Canon EF lens mount 

camera 
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Electrical Connectivity 
The Cheetah camera has two external inputs, INPUT1 and INPUT2. INPUT1 is optically isolated 
while INPUT2 accepts low voltage TTL (LVTTL). The camera provides two general-purpose 
outputs. Output OUT1 is a 5 V TTL compatible signal and output OUT2 is opto-isolated. The 
following figures show the external input and output electrical connections. 

Opto-Isolated Input 
Input signals INPUT1 and INPUT1 RTN are optically isolated. The voltage difference between the 
two must be positive between 3.3 V and 24 V. The minimum input current is 3.3 mA. 

 

TTL/LVTTL Input 
Input signals INPUT2 and INPUT2 RTN provide interfaces to a TTL or LVTTL input signal. The signal 
level (voltage difference between the inputs INPUT2 and INPUT2 RTN) must be LVTTL (3.3 V) or 
TTL (5.0 V). The total maximum input current must not exceed 2.0 mA.  

 

TTL Output 
TTL output provides interface to a TTL compatible output signal. The signal level (voltage 
difference between the outputs OUT1 and OUT1 RTN) is TTL (5.0 V). The maximum output 
current must not exceed 8.0 mA.  

 

INPUT1 
(pin8) 

INPUT1 RTN 
(pin 10) 

INPUT2 
(pin 9) 

INPUT2 RTN 
(pin 11) 

OUT1 
(pin 7) 

OUT1 RTN 
(pin 6) 
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Opto-Isolated Output 
Opto-isolated output is an optically isolated switch. There is no pull-up voltage on either contact. 
An external pull-up voltage of up to 25 V is required for operation. Output is not polarity 
sensitive. AC or DC loads are possible. The voltage across Contact 1 and Contact 2 must not 
exceed 25 V and the current through the switch must not exceed 50 mA. ‘On’ resistance is less 
than 5 Ohms. 

OUT2 Open drain logic driver circuit: 

 

OUT2 Low side load driver circuit: 
 

 
 

 

 

 

 

 

 

VS – from 2.5 V to 25 V (DC or peak AC) 
R2 – from 50 R to 500 R 
IL – from 1 mA to 50 mA 



Cheetah Pregius Camera with 10 GigE Vision Interface – User Manual  

 May 6, 2021 Page 28 of 181  Rev 1.1 

OUT2 High side load driver circuit: 

 
 
  

VS – from 2.5 V to 25 V (DC or peak AC) 
R3 – from 50 R to 500 R 
IL – from 1 mA to 50 mA 
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Mechanical Drawings 
The camera housing is made of precision-machined aluminum. For maximum flexibility, the 
camera has eight M3X0.5mm mounting holes located towards the front of the camera on all four 
sides. An additional plate with ¼-20 UNC (tripod mount) and hardware ship with each camera. 
 

 
 

SFP-C4440, SFP-C5440, and SFP-C6440 Cameras 

Front View:      Back View: 
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Top View: 

 
 
 
Left Side View: 
 

 
 
 
Right Side View with Image Plane: 
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Mounting Plate 
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Optical 
The Cheetah 10GigE SFP cameras come with an adapter for F-mount lenses that have a 46.50 
mm back focal distance. 

The camera can also be equipped with M42, Canon EF EOS Active or Passive mounts (refer to the 
section Ordering Information). 

The camera is highly sensitive in the infrared (IR) spectral region. All color cameras have an IR 
cut-off filter installed. Monochrome cameras do not have any optical filter. If necessary, the 
monochrome camera can accommodate an IR filter (1 mm thickness or less) inserted under the 
front lens bezel.  
 
 

Avoid direct exposure to a high intensity light source 
(such as a laser beam). This may damage the image 
sensor! 
 
Avoid foreign particles on the surface of the image 
sensor. 
 
Do not use methylated alcohol for cleaning the image 
sensor!  
Please refer to the Sensor Cleaning Procedure document 
found in the camera’s information ZIP file or contact 
Imperx support for cleaning procedures. 
 
Avoid touching or cleaning the front surface of the 
image sensor. If the sensor needs cleaning, use soft lint 
free cloth and an optical cleaning fluid. 

 
 
 
 

Camera performance and signal to noise ratio (SNR) depend on the 
illumination (amount of light) reaching the sensor and the exposure time. 
Always try to balance these two factors. Unnecessarily long exposures 
increase the amount of dark noise and thus decrease the signal to noise 
ratio.  

 
 
 
 
 
 

  



Cheetah Pregius Camera with 10 GigE Vision Interface – User Manual  

 May 6, 2021 Page 33 of 181  Rev 1.1 

Environmental 
Always operate the camera within temperature and humidity specifications listed below: 
 

Specification Definition 

Operating temperature -30 °C to +70 °C (with a fiber 10GBase-R transceiver module); 
(may vary depending on the transceiver module used) 
 
-30 °C to +45 °C (with a copper 10GBase-T transceiver module) 

Storage temperature -40 °C to + 85 °C 

Relative humidity 10% to 90% 
 
 
 

Avoid direct exposure to moisture and liquids. The 
camera housing is not hermetically sealed and any 
exposure to liquids may damage the camera electronics! 
 
Avoid operating the camera in the environment without 
any air circulation, near an intensive heat source, strong 
magnetic or electric fields. 
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Handling the Camera 
 
 
 

When mounting the camera, make sure the inlet and 
outlet openings are not blocked by surrounding objects. 
The fan automatically turns on if the internal camera 
temperature exceeds 65 °C. Keep the fan inlet and 
outlet clear of obstructions. 

Do not touch the camera for at least 20 minutes after 
shutting it down. Allow the camera to cool down. Hot 
surface may cause burns. 

 
 
 
 

 

 

inlet opening on top of the camera 

outlet opening on the left side of the camera 
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GenICamTM API Module – 
Configuring the Camera 

Overview 
Imperx Cheetah cameras are highly programmable and flexible. They allow control of all the 
camera’s resources, camera settings, internal registers, video amplifiers, parameter flash, and so 
on. You communicate with the camera from a simple GenICam compliant graphical user 
interface (GUI). The GUI is bi-directional allowing you to issue commands to the camera and 
allowing the camera to issues responses (either status or information).  

The Cheetah camera ships with the Imperx Camera SDK software which includes the SDK and 
IpxPlayer application to control the camera and view/save images. 

Camera Startup 
Upon powering up or receiving a DeviceReset command, the camera performs the following 
steps: 
 
1. Boot loader checks program flash memory for a valid firmware image and loads it into the 

field-programmable gate array (FPGA). 
 

2. The camera reads the Boot From register from the parameter Flash and loads a workspace 
from one of the configuration spaces determined by the User Set Default selector. The 
configuration spaces are: Factory Space (Default), User Space (User set 0–User Set 3). 

 
3. The camera runs the IP configuration according the GigE Vision standard, obtains the IP 

address, and is ready for device enumeration by host application. 

GenApi Camera Configuration 
The camera XML nodes are listed below with a description of the camera configuration 
parameters, the interface type, the range of control values, and the access mode for the 
parameter (RW: Read/Write, RO: Read Only, WO: Write Only). 
 
 

In the following tables, parameter names highlighted in red italic letters are 
changeable only if image acquisition is turned off. You cannot change these 
parameters if image acquisition is on. After making changes, you can turn the 
camera image acquisition back on. 
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Device Control 
Device Control provides read-only information about the camera’s XML file and enables camera 
reset functionality. 
 

Parameter Name Type Value Access Description 

DeviceVendorName String  RO Provides the name of the 
manufacturer of the camera 

DeviceModelName String  RO Provides the model of the 
device 

DeviceVersion String  RO Provides the version of the 
camera 

DeviceFirmwareVersion String  RO Provides firmware version of 
the camera 

DeviceManufacturerInfo String  RO Provides extended 
manufacturer information 
about the camera 

DeviceSerialNumber String  RO Provides serial number of the 
camera 

DeviceUserID String  RW Provides user defined name 
of the device 

DeviceSFNCVersionMajor Integer  RO Major version of SFNC used 
for XML. 

DeviceSFNCVersionMinor Integer  RO Minor version of SFNC used 
for XML 

DeviceSFNCVersionSubMinor Integer  RO Sub-minor version of SFNC 
used for XML 

DeviceScanType Enumeration String 
Areascan 

Num. 
0 

RO Specifies the scan type of the 
sensor 

DeviceReset Command  WO Resets camera to power-up 
state (resets both the 10G 
Engine and the camera head) 

CameraHeadReset Command  WO Resets the camera circuitry. 
The 10G Engine does not 
reset. NOTE: After a camera 
reset, issue a UserSetLoad 
command 

SensorTemperature Float  RO Returns the current sensor 
temperature  

SensorBoardTemperature Float  RO Returns the current sensor 
board temperature 

FPGATemperature Float  RO Returns the current FPGA 
temperature 

FPGABoardTemperature Float  RO Returns the current FPGA 
board temperature. 
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Temperature Control 
Temperature Control allows you to set the fan’s operation mode and the temperature at which 
the fan turns on in Auto mode.  
 

The fan automatically turns on—even if the fan operation mode is Off—
when the internal camera temperature exceeds 65 °C. 

 
 
Parameter Name Type Value Access Description 

FanMode Enumeration String 
Off 
On 
Auto 

Num. 
0 
1 
2 

RW Sets the operation mode of the 
camera fan. 

FanOnTemperature Float  RW Sets the temperature, in Celsius 
degrees, when the camera fan turns 
on to cool the camera (in Auto 
mode). Fan turns off when the 
internal camera temperature is 4 °C 
below the set temperature.  
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Version Information 
Version Information provides read-only information identifying the camera’s firmware, 
hardware, software, image sensor, camera version, and so on. This information is programmed 
during the manufacturing process and stored in non-volatile memory. 
 
Parameter Name Type Value Access Description 

SensorType Enumeration String                    Num. 
Monochrome      0 
Bayer                    1 

RO Returns the CMOS 
sensor type. 

SensorModel Enumeration String             Num. 
Unknown       0 
IMX342LQ     0x00000156 
IMX342LL      0x00000556 
IMX367LQ     0x0000016F 
IMX367LL      0x0000056F 
IMX387LQ     0x00000183 
IMX387LL      0x00000583 

RO Returns the CMOS 
model name. 

RgsID Integer  RO Returns RGS ID. 

FirmwareImage Integer  RO Returns the firmware 
image ID (F=Factory or 
A= Application). 

CameraHeadFirmwareVersion Integer 
 

RO Returns the camera 
head firmware version 
number. 

CameraHeadFirmwareBuild Integer  RO Returns the camera 
head firmware build 
number. 

FirmwareVersion Integer 
 

RO Returns the firmware 
version number. 

FirmwareBuild Integer  RO Returns firmware build 
number. 

CustomerID Integer  RO Returns Customer ID for 
custom cameras  
(0 = Imperx Standard 
camera). 

FamilyID Integer  RO Returns the camera 
family ID. 

XMLVersion Integer  RO Returns XML version. 
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Image Format Control 
Image Format Control lets you change screen resolution, select pixel format, and more. 
 
Parameter Name Type Value Access Description 

SensorWidth Integer  RO Returns effective width 
of sensor in pixels. 

SensorHeight Integer  RO Returns effective height 
of sensor in pixels. 

WidthMax Integer  RO Returns max. width of 
image in pixels  for 
OffsetX=0 calculated 
after horizontal binning, 
decimation, or other 
functions are applied. 

HeightMax Integer  RO Returns max. height of 
image in pixels OffsetY=0 
calculated after 
horizontal binning, 
decimation, or other 
functions are applied. 

Width Integer Min: Depends on PixelFormat 
Max: Depends on camera model 

RW Represents actual image 
output width of master 
AOI (in pixels). 

Height Integer Min: Depends on PixelFormat 
Max: Depends on camera model 

RW Represents actual image 
output height of master 
AOI (in pixels). 

OffsetX Integer Min: 0 
Max: Depends on Width 

RW Horizontal offset from 
origin to area of interest 
(in pixels). 

OffsetY Integer Min: 0 
Max: Depends on Height 

RW Vertical offset from 
origin to area of interest 
(in pixels). 

PixelSize Enumeration String 
Bpp8 
Bpp10 
Bpp12 

Num. 
0 
1 
2 

RO Number of bits per pixel. 

PixelColorFilter Enumeration String 
None 
BayerRG 
BayerGB 
BayerGR 
BayerBG 

Num. 
0 
1 
2 
3 
4 

RO Returns type of color 
filter that is applied to 
the image.  
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Parameter Name Type Value Access Description 

PixelFormat Enumeration String 
Mono8 
Mono10 
Mono10Packed 
Mono12 
Mono12Packed 
BayerGR8 
BayerRG8 
BayerGB8 
BayerBG8 
BayerGR10 
BayerRG10 
BayerGB10 
BayerBG10 
BayerGR12 
BayerRG12 
BayerGB12 
BayerBG12 
BayerGR10Packed 
BayerRG10Packed 
BayerGB10Packed 
BayerBG10Packed 
BayerGR12Packed 
BayerRG12Packed 
BayerGB12Packed 
BayerBG12Packed 

Num. 
0x01080001 
0x01100003 
0x010C0004 
0x01100005 
0x01100005 
0x01080008 
0x01080009 
0x0108000A 
0x0108000B 
0x0110000C 
0x0110000D 
0x0110000E 
0x0110000F 
0x01100010 
0x01100011 
0x01100012 
0x01100013 
0x010C0026 
0x010C0027 
0x010C0028 
0x010C0029 
0x010C002A 
0x010C002B 
0x010C002C 
0x010C002D 

RW Sets output data pixel 
format. Color cameras, 
without image flipping 
or reversal, use 
BayerRG8, BayerRG10 or 
BayerRG12, 
BayerRG10Packed or 
BayerRG12Packed 
format. 

BinningVerticalMode1 Enumeration String 
Sum 

Num. 
0 

RO Returns the mode used 
to combine horizontal 
photo-sensitive cells 
together when 
BinningVertical is used.  

BinningVertical Integer Min: 1 
Max: 2 

RW Number of vertical 
photo-sensitive cells to 
combine. This reduces 
the vertical resolution 
(height) of the image 

BinningHorizontalMode1 Enumeration String 
Sum 

Num. 
0 

RO Returns the mode used 
to combine horizontal 
photo-sensitive cells 
together when Binning 
Horizontal is used. 

BinningHorizontal Integer Min: 1 
Max: 2 

RW Number of horizontal 
photo-sensitive cells to 
combine. This reduces 
the horizontal resolution 
(width) of the image.  
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Parameter Name Type Value Access Description 

DecimationVertical Integer Min: 1 
Max: 2 

RW Vertical sub-sampling of 
the image. This reduces 
the vertical resolution 
(height) of the image by 
the specified vertical 
decimation factor. 

DecimationHorizontal Integer Min: 1 
Max: 2 

RW Horizontal sub-sampling 
of the image. This 
reduces the horizontal 
resolution (width) of the 
image by the specified 
horizontal decimation 
factor. 

ReverseX2 Boolean  RW Horizontally flips the 
image output. Any area 
of interest is applied 
after the flipping. The 
PixelFormat of color 
cameras changes 
automatically. 

ReverseY2 Boolean  RW Vertically flips the image 
output. Any area of 
interest is applied after 
the flipping. The 
PixelFormat of color 
cameras changes 
automatically. 

TestPattern3 Enumeration String 
Off 
GreyHorizontalRamp 
GreyVerticalRamp 
GreyHorizontalRampMovi
ng 
GreyVerticalRampMoving 
FlatField 
IpxGevPattern 

Num 
0 
1 
2 
 
3 
4 
5 
16 

RW Selects type of test 
pattern generated by 
the camera replacing the 
image sensor as the 
source (refer to section 
Test Image Pattern 
for more information). 

SensorTestPattern4 Enumeration String 
Off 
Mode0 
Mode1 

Num 
0 
1 
2 

RW Selects the type of test 
pattern that is 
generated by the 
camera image sensor.  
Mode0 and Mode1 are 
used to verify the 
sensor’s connectivity to 
an FPGA 

AdcBitDepth Enumeration String 
Bit10 
Bit12 

Num 
10 
12 

RO Returns which ADC bit 
depth is used. A higher 
ADC bit depth results in 
better image quality but 
slower maximum frame 
rate. 
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Parameter Name Type Value Access Description 

SensorShutterMode Enumeration String 
Global 

Num 
1 

RO Returns the shutter 
mode of the device. 

1BinningHorizontal/Vertical Mode value: 
Sum: The response from the combined cells is added, resulting in increased sensitivity. 

 
Currently, the camera performs Summation mode only. 
 
To enable binning feature, set BinningHorizontal or BinningVertical to 2. 
 
The binning is disabled when DecimationVertical or DecimationHorizontal is 
enabled, and vice versa. 
 

2When ReverseX and/or ReverseY are enabled for a color camera, the PixelFormat changes 
automatically according to the current Bayer pattern start pixel: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3Test Pattern values: 

Off: Image is coming from the sensor  

GreyHorizontalRamp: Image is filled horizontally with a 
digital pattern that goes from the darkest possible value 
to the brightest. 

 

GreyVerticalRamp: Image is filled vertically with a digital 
pattern that goes from the darkest possible value to the 
brightest. 

 

G R 

B G 

R G 

G B 

ReverseX is enabled 
New PixelFormat: BayerGR8 

B G 

G R 

ReverseY is enabled 
New PixelFormat: BayerGB8 

G B 

R G 

ReverseX and ReverseY are 
enabled together 

New PixelFormat: BayerBG8 

Original PixelFormat: BayerRG8 

Y 

X 
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GreyHorizontalRampMoving: Image is filled horizontally 
with digital pattern that goes from the darkest possible 
value to the brightest and that moves horizontally from 
left to right at each frame. 

 
GreyVerticalRampMoving: Image is filled vertically with 
digital pattern that goes from the darkest possible value 
to the brightest and that moves vertically from top to 
bottom at each frame. 

 
FlatField: Displays a constant grey level for all display 
pixels. 

 
IpxGevPattern: GEV engine firmware generate an image. 

 
 
4Sensor Test Pattern values: 

Mode0: The sensor test image is filled with a vertical 
stripe pattern of one pixel width. Values are: 
12-bit: FFFh/555h/AAAh/000h 
10-bit: 3FFh/155h/2AAh/000h 
8-bit: FFh/55h/Aah/00h 
 
This ensures that the connection between the sensor and 
FPGA is synchronized. 
 
*For color cameras, make sure that BalanceRatio is set to 
1.0 and BalanceWhiteAuto is Off. 

 

Mode1: The sensor test image is filled horizontally with 
digital pattern that goes from the darkest possible value 
to the brightest. 
This ensures that the connection between the sensor and 
FPGA is synchronized. 
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Acquisition Control 
Acquisition Control lets you configure settings for image capture, exposure, frame rates, triggers, 
and so on. It also provides read-only information on frame and exposure time. 
 
Parameter Name Type Value Access Description 

AcquisitionMode Enumeration String 
SingleFrame 
MultiFrame 
Continuous 

Num. 
0 
1 
2 

RW Defines the number of 
frames to capture during 
acquisition and the way 
the acquisition stops 

AcquisitionStart Command  WO Starts device acquisition. 

AcquisitionStop Command  WO Stops acquisition after 
current frame completes 
readout. 

AcquisitionAbort Command  WO Stops acquisition 
immediately; a partially 
transferred image will be 
completed. 

AcquisitionFrameCount Integer Min: 1 
Max: 65535 

RW Sets the number of frames 
to be acquired in 
MultiFrame 
AcquisitionMode. 

ExposureMode1 Enumeration String 
Off 
Timed 
TriggerWidth 

Num. 
0 
1 
2 

RW Sets exposure mode (refer 
to Exposure Control for 
more information). 

ExposureTime2 Float  RW Sets the exposure time in 
microseconds when 
ExposureMode is Timed 
and ExposureAuto is Off. 

ExposureAuto Enumeration String 
Off 
Once 
Continuous 

Num. 
0 
1 
2 

RW Sets the automatic 
exposure mode when 
ExposureMode is Timed. 

AcquisitionFrameRateEn
able 

Boolean  RW Controls if the 
AcquisitionFrameRate and 
AcquisitionFrameTime 
features are writable and 
used to control the 
acquisition rate. If On, you 
can extend the actual 
frame time beyond the 
free-running frame time. 
Trigger is disabled and 
cannot be used in 
combination with this 
feature. 

AcquisitionFrameTime Integer  RW Sets Frame Time in 
microseconds.  
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Parameter Name Type Value Access Description 

AcquisitionFrameRate Float  RW Controls the acquisition 
rate (in Hz) of frames 
captured. 

AcquisitionLineTimeEna
ble 

Boolean  RW Controls if the 
AcquisitionLineTime 
feature are writable and 
used to control the 
acquisition line time. 

AcquisitionLineTime Integer  RW This feature sets the actual 
line time in pixel clocks 
(74.25MHz). 

AcquisitionBurstFrameC
ount 

Integer Min: 1 
Max: 65535 

RW Number of frames to 
acquire for each trigger. 

CurrentExposureTime Integer  RO Returns current exposure 
time in microseconds. 

CurrentFrameTime Integer  RO Returns current frame 
time in microseconds. 

TriggerMode Enumeration String 
Off 
On 

Num. 
0 
1 

RW Enables Trigger mode of 
operation. Not available if 
AcquisitionFrameRateEnab
le parameter is On. 

TriggerSoftware Command  WO Generates internal trigger. 
TriggerSource must be set 
to Software. 

TriggerSource3 Enumeration String 
Line1 
Line2 
PulseGenerator 
Software 

Num. 
0 
1 
4 
5 

RW Specifies internal signal or 
external Line as trigger 
source. TriggerMode must 
be set to On (refer to 
Trigger Sources for more 
information). 

TriggerActivation Enumeration String 
RisingEdge 
FallingEdge 

Num. 
0 
1 

RW Specifies activation edge of 
trigger. 

TriggerOverlap Enumeration String 
Off 
ReadOut 

Num. 
0 
1 

RW Specifies the trigger 
overlap mode, if the 
camera receives a trigger 
pulse while processing the 
previous trigger. 
Off – Standard Trigger 
mode; ReadOut – Fast 
Trigger mode. 

TriggerDebounceTime Integer Min: 0 
Max: 65535 

RW Specifies time period (in 
microseconds) when a 
second trigger is not 
accepted. 
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Parameter Name Type Value Access Description 

TriggerFilterTime Integer Min: 0 
Max: 65535 

RW Specifies the minimum 
Trigger signal pulse width. 
Any pulse shorter than the 
selected time is ignored. 

TriggerDelay Integer Min: 0 
Max: 16000000 

RW Specifies delay between 
trigger and start of 
exposure (in 
microseconds). 

1Exposure Mode values: 
Off Disables the Exposure. The exposure time is equal to frame time. 

Timed The exposure duration is set by the ExposureTime or ExposureAuto 
features. 

TriggerWidth The exposure duration is set by the width of the current trigger signal 
pulse. Note that if TriggerActivation is set to RisingEdge, the exposure 
duration will be the time the trigger stays high. If TriggerActivation is set 
to FallingEdge, the exposure time lasts as long as the trigger stays low. 

 

2ExposureTime: The maximum exposure time is equal to the frame time. For longer exposure 
times, increase the frame period using the AcquisitionFrameTime or AcquisitionFrameRate 
features. 

 

3TriggerSource values: 
Line1 Hardware Input Line GP Input 1 (Trigger 1) is used as external source for 

the trigger signal. 

Line2 Hardware Input Line GP Input 2 (Trigger 2) is be used as external source 
for the trigger signal. 

PulseGenerator Specifies that the trigger source will be generated by camera’s internal 
Pulse Generator. 

Software Specifies that the trigger source will be generated by software using the 
TriggerSoftware command. 
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Analog Control 
Analog Control provides parameters for configuring gain, black level, gamma correction, and 
auto white balance. 
 
Parameter Name Type Value Access Description 

Gain Float Min: 0.0 
Max: 48.0 

RW Controls the selected gain as an 
absolute physical value. This is an 
amplification factor applied to the 
video signal. 

GainAuto Enumeration String 
Off 
Once 
Continuous 

Num. 
0 
1 
2 

RW Sets the automatic gain control 
(AGC) mode. ExposureMode can 
be set to Timed, PulseWidth, or Off.  

BlackLevel Float Min: 0.0 
Max: 4095.0 

RW Controls the on-sensor analog black 
level as an absolute physical value. 
This represents a DC offset applied 
to the video signal. 

SensorBlackLevelRecomm
ended 

Boolean  RW Uses recommended value of 
BlackLevel from the sensor. 

BlackLevelAuto Enumeration String 
Off 
Continuous 

Num. 
0 
1 

RW Sets the on-sensor mode for 
automatic black level adjustment. 

DigitalGain Float Min: 0.0 
Max: 4.0 

RW Controls the Digital Gain. 

DigitalBlackLevel Float Min: -4096.0 
Max: 4095.0 

RW Controls the Digital Black Level. 

BalanceRatioSelector Enumeration String 
Red 
Blue 

Num. 
0 
1 

RW White Balance Control: Selects 
which color will be impacted by the 
BalanceRatio control. 

BalanceRatio Float Min: 0.25 
Max: 4.00 

RW White balance color ratio. Controls 
ratio of the selected color 
component to green, which is the 
reference color. If the Red and Blue 
Balance ratios are manually set to 
1.0, no white balance correction is 
applied to the pixels. 

BalanceWhiteAuto Enumeration String 
Off 
Once 
Continuous 

Num. 
0 
1 
2 

RW Controls the mode for automatic 
white balancing between the color 
channels. The white balancing color 
ratios are automatically adjusted by 
selecting either Once or 
Continuous. If Off, the White 
Balance color ratios are set 
manually using 
BalanceRatioSelector and 
BalanceRatio controls.  
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Auto White Balance, Exposure and Gain Algorithm Control 
Auto Algorithm Control lets you configure settings for AWB (Automatic White Balance),  
AEC (Automatic Exposure Control), and AGC (Automatic Gain Control) algorithms. 
 
You can set the camera to AEC/AGC to keep the same image brightness during changing lighting 
conditions. On the Auto Algorithm Control panel, you can configure the range of exposure times 
and gain values for AEC/AGC by placing minimum and maximum limits on these parameters. 

 
Parameter Name Type Value Access Description 

BalanceWhiteAutoLowerLimit Float Min: 0.25 
Max: 
BalanceWhiteAutoLowerLimi
tMax 

RW Controls the minimum 
value AWB can set for 
the Red/Blue 
BalanceRatio. 

BalanceWhiteAutoUpperLimit Float Min: 0.25  
Max: 
BalanceWhiteAutoUpperLimi
tMax 

RW Controls the 
maximum value AWB 
can set for the 
Red/Blue 
BalanceRatio. 

BalanceWhiteAutoSpeed Integer Min: 1 
Max: 64 

RW Speed of AWB 
algorithm. 1 is 
slowest, 64 is fastest. 

ExposureAutoLowerLimit Float Min: ExposureTimeMin 
Max: ExposureAutoUpperLimit 

RW The shortest exposure 
time that Auto 
Exposure can set 

ExposureAutoUpperLimit Float Min: ExposureAutoLowerLimit 
Max: ExposureTimeMax 

RW The longest exposure 
time that Auto 
Exposure can set. 

GainAutoLowerLimit Float Min: 0.0 
Max: GainAutoUpperLimit 

RW The lowest gain that 
Auto Gain can set. 

GainAutoUpperLimit Float Min: GainAutoLowerLimit 
Max: 48.0 

RW The highest gain that 
Auto Gain can set. 

ExposureGainAutoPriority Enumeration String 
Gain 
ExposureTime 

Num. 
0 
1 

RW Selects whether to 
adjust gain or 
exposure first.  

ExposureGainAutoMode Enumeration String 
Average 

Num. 
0 

RO Shows what 
luminance mode is 
used during AGC or 
AEC. 

ExposureGainAutoTarget Integer Min: 1 
Max: 4095 

RW Sets the desired 
luminance level to be 
maintained during 
AGC or AEC with 12-
bits per pixel. 
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Parameter Name Type Value Access Description 

ExposureGainAutoTargetThres
hold 

Integer Min: 0 
Max: 4095 

RW Sets the acceptable 
steady-state error of 
the luminance level to 
be maintained during 
AGC or AEC. Normal 
initial setting for 
stability is 16.  

AverageLuminosity Integer  RO Shows average 
luminosity of the 
image. 

CurrentFrameCounterLow Integer  RO Shows number of 
frames captured since 
the camera power up 
(lower 32 bits). 

CurrentFrameCounterHigh Integer  RO Shows number of 
frames captured since 
the camera power up 
(upper 32-bits). 
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Exposure Auto PID Coefficients 
 
 

Imperx do not recommend changing min and max limits of the 
P coefficient. Doing so may cause oscillations and destabilize a 
PID controller. Imperx sets up optimal values to balance the 
speed and stability of the AEC algorithm. 
 
If you need to change the P coefficient, please contact Imperx 
support. 

 
 
 
Parameter Name Type Value Access Description 

ExposureAutoPMin Float Min: 0.0 
Max: 256.0 

RW Controls the minimum of 
the P coefficient for 
Exposure Auto control 
loop. 

ExposureAutoPMax Float Min: 0.0 
Max: 256.0 

RW Controls the maximum of 
the P coefficient for 
Exposure Auto control 
loop. 

ExposureAutoExposureForPMax Float Min: ExposureTimeMin 
Max:  

RW Maps the maximum of the 
P coefficient to the value 
of exposure in the 
Exposure Auto control 
loop. 

 

Please refer to the section P, I, and D Coefficients for more information. 
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Gain Auto PID Coefficients 
 
 

Imperx does not recommend changing the P, I, and D 
coefficients. Doing so may cause oscillations and destabilize a 
PID controller. Imperx sets up optimal values to balance the 
speed and stability of the AGC algorithm. 
 
If you need to change the P, I, and D coefficients, please 
contact Imperx support. 

 
 
 
Parameter Name Type Value Access Description 

GainAutoPcoef Float Min: 0.0 
Max: 256.0 

RW Controls the P coefficient for Gain 
Auto control loop. 

GainAutoIcoef Float Min: 0.0 
Max: 256.0 

RW Controls the I coefficient for Gain 
Auto control loop. 

GainAutoDcoef Float Min: 0.0 
Max: 256.0 

RW Controls the D coefficient for Gain 
Auto control loop. 

 

Please refer to the section P, I, and D Coefficients for more information. 
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Data Correction 
Data Correction parameters enable you to implement look-up tables and other techniques to 
improve image sensor performance. 
 
Parameter Name Type Value Access Description 

LUTEnable Enumeration String  
Off 
LUT1 
LUT2 
LUT3 
LUT4 

Num. 
0 
1 
2 
3 
4 

RW Selects and enables LUT to be 
used in processing image. 
(LUT1 and LUT3 are 
preprogrammed with Gamma 
0.45, LUT 2 and LUT 4 – with 
negative function) 

FFCEnable Enumeration String  
Off 
FactoryFFC 
FFC1 
FFC2 
FFC3 
FFC4 
FFC5 
FFC6 
FFC7 

Num. 
0 
1 
2 
3 
4 
5 
6 
7 
8 

RW Selects FFC to be used in 
processing image. 

DefectPixelCorrection Enumeration String 
Off 
Factory 
User 

Num. 
0 
1 
2 

RW Enables defect pixel 
correction. You can upload 
your own defect pixel map. 

DefectPixelCorrectionMode1 Enumeration String 
Average 
Highlight 
Zero 

Num. 
0 
1 
2 

RW Controls the method used for 
replacing defective pixels 
(Highlight and Zero are for 
testing purposes only) 

BadPixelCorrection Enumeration String 
Off 
Factory 
User 

Num. 
0 
1 
2 

RW Enables Hot Pixel Correction. 
You can upload your own hot 
pixel map. 

BadPixelCorrectionMode1 Enumeration String 
Average 
Highlight 
Zero 

Num. 
0 
1 
2 

RW Controls the method used for 
replacing hot pixels (Highlight 
and Zero are for testing 
purposes only). 

DefectPixelCountMax Integer  RO Maximum number of pixels in 
the Defect Pixel Correction 
Table. 

BadPixelCountMax Integer  RO Maximum number of pixels in 
the Hot Pixel Correction Table. 

1DefectPixelCorrectionMode and BadPixelCorrectionMode values: 
Average Defective or Hot Pixels are replaced with the average of their neighbors. 

Highlight Defective or Hot Pixels are replaced with the maximum pixel value. 

Zero Defective or Hot Pixels are replaced by the value zero. 
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Digital Input / Output Control 
Digital Input / Output Control allows you to map camera’s inputs and outputs and configure 
strobes. 
 
Parameter Name Type Value Access Description 

LineSelector Enumeration String  
Input1 
Input2 
Output1 
Output2 

Num. 
0 
1 
2 
3 

RW Selects the physical line (or pin) of 
the external camera connector or 
the virtual line of the Transport 
Layer to configure. 

LineMode Enumeration String  
Input 
Output 

Num. 
0 
1 

RO Returns the status of the physical 
line used to input or output a 
signal. 

LineInverter Boolean  RW Controls the inversion of the 
signal of the selected input or 
output line. 

LineStatus Boolean logic 1 – true 
logic 0 – false 

RO Returns the current signal level on 
the selected input or output line. 

LineSource1 Enumeration String  
Off 
ExposureStart 
ExposureEnd 
MidExposure 
ExposureActive 
TriggerActual 
TriggerDelayed 
PulseGenerator 
Strobe1 
Strobe2 

Num. 
0 
1 
2 
3 
4 
5 
6 
7 
8 
9 

RW Selects which internal signal to 
output on the selected line. 
LineSelector must be set to 
Output. 

LineFormat2 Enumeration String  
NoConnect 
TriState 
TTL 
OptoCoupled 

Num. 
0 
1 
2 
3 

RO Returns the current electrical 
format of the selected physical 
input or output line. 

Strobe1Reference Enumeration String  
Exposure 
Readout 
Trigger 

Num. 
0 
1 
2 

RW Sets the reference event for 
Strobe #1 signal. 

Strobe1Enable Enumeration String  
Off 
On 

Num. 
0 
1 

RW Enables or disables the Strobe #1. 

Strobe1Width Integer Min: 10 
Max: 16000000 

RW Sets Strobe #1 pulse duration in 
microseconds. 

Strobe1Delay Integer Min: 0 
Max: 16000000 

RW Sets Strobe #1 delay from the 
reference, in microseconds. 
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Parameter Name Type Value Access Description 

Strobe2Reference Enumeration String  
Exposure 
Readout 
Trigger 

Num. 
0 
1 
2 

RW Sets the reference event for 
Strobe #2 signal. 

Strobe2Enable Enumeration String  
Off 
On 

Num. 
0 
1 

RW Enables or disables the Strobe #2. 

Strobe2Width Integer Min: 10 
Max: 16000000  

RW Sets Strobe #2 pulse duration in 
microseconds. 

Strobe2Delay Integer Min: 0 
Max: 16000000 

RW Sets Strobe #2 delay from the 
reference, in microseconds. 

1LineSource values (for outputs only): 

ExposureStart A short pulse indicating the beginning of the exposure 

ExposureEnd A short pulse indicating the end of the exposure 

MidExposure A short pulse indicating the middle of the exposure 

ExposureActive The output signal is active for the duration of exposure time 

TriggerActual Maps the input trigger pulse to the output with no delay 

TriggerDelayed Maps the input trigger pulse to the output with trigger delay 

PulseGenerator Maps the internal pulse generator waveform to the output 

Strobe1 Maps the Strobe 1 signal to the corresponding external output 

Strobe2 Maps the Strobe 2 signal to the corresponding external output 

 

2LineFormat values: 

NoConnect The line is not connected 

TriState The line is currently in Tri-State mode (Not driven) 

TTL The line is currently accepting or sending TTL level signals 

OptoCoupled The line is opto-coupled 

 
 
You can monitor the current logic level (1 or 0) of the signal on the selected input or output by 
using the LineStatus parameter. 

The LineMode parameter shows the status of the selected input or output line.  
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Depending on line selected under LineSelector (Input or Output), you can apply the following 
controls: 

LineSelector Available controls Values 

Input1 or Input2 LineInverter True 
False 

Output1 or Output2 LineInverter True 
False 

LineSource Off 
ExposureStart 
ExposureEnd 
MidExposure 
ExposureActive 
TriggerActual 
TriggerDelayed 
PulseGenerator 
Strobe1 
Strobe2 
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Pulse Generator 
The camera provides an internal pulse generator for generating a trigger signal. You can program 
it to generate a discrete sequence or a continuous trail of pulse signals. 
 
Parameter Name Type Value Access Description 

PulseGenGranularity Enumeration String  
x1uS 
x10uS 
x100uS 
x1000uS 

Num. 
0 
1 
2 
3 

RW Sets the multiplication 
factors of the Pulse 
Generator where  
x1 = 1 µS, x10=10 µS, etc. 

PulseGenWidth Integer  RW Sets pulse width of Pulse 
Generator where each unit 
is equal to 
PulseGenGranularity. 

PulseGenPeriod Integer  RW Sets pulse period of Pulse 
Generator where each unit 
is equal to 
PulseGenGranularity. 

PulseGenNumPulses Integer Min: 1 
Max: 65536 

RW Sets number of pulses to be 
generated by Pulse 
Generator. 

PulseGenMode Enumeration String  
Continuous 
NumPulses 

Num. 
0 
1 

RW Sets the mode of the Pulse 
Generator. 

PulseGenEnable Boolean  RW Enables Pulse Generator. 
The pulse generator output 
can be mapped to the 
OUTPUT1 or OUTPUT2 
output signals. It also can be 
used as a trigger source. 
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Canon Lens Control 
Canon EF Lens supports motorized iris and focus (not zoom). Canon Lens Control parameters give 
you control over iris and focus position. Refer to the Canon Lens Control section for more 
information on lens adjusting procedures. 

Controller Settings 
 
Parameter Name Type Value Access Description 

InitLens Command  WO Initializes the Canon Lens. 
Always Initialize lens after 
power up. 

StopLens Command  WO Removes power from the Iris 
drive. Run the InitLens 
command to resume the lens 
control. 

LensControllerStatus Enumeration String 
InitLens_Failed 
InitLens_Done 

Num. 
0 
1 

RO Shows status of Canon Lens 
initialization. 

LensAF_MF Enumeration String 
AutoFocus 
ManualFocus 

Num. 
0 
1 

RO Shows status of Auto/Manual 
focus switch located on the 
lens. 

GetLensID  Command  WO Requests value of Lens ID 
register. 

LensID  Integer  RO Returns Lens ID after the 
GetLensID command is issued. 
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Focus 
 
Parameter Name Type Value Access Description 

NearFull Command  WO Drives the focus to the fully Near 
position. 

FarFull Command  WO Drives the focus to the fully Far 
position. 

FocusSetupValue Integer Min: 1 
Max: 255 

RW Sets the focus step used with 
NearStep and FarStep 
commands. 

NearStep Command  WO Drives the focus to the Near 
direction by the amount defined 
in the FocusStepValue feature. 

FarStep Command  WO Drives the focus in the Far 
direction by the amount defined 
in the FocusStepValue feature. 

FocusReqPosition Integer Min: 0 
Max: FocusMaxReg 

RW Sets the desired focus value to 
use with the SetFocusPosition 
command. 

SetFocusPosition Command  WO Drives the focus to the absolute 
position defined in the 
FocusReqPosition feature. 

FocusMax Integer  RO Returns Maximum Focus Limit  

FocusSetMax Command  WO Sets the Maximum Focus Limit 

GetFocusEncoderStatus Command  WO Requests the focus encoder 
position value. 

FocusEncoderStatus Integer  RO Returns the current focus 
encoder value after the 
GetFocusEncoderStatus 
command issued. 

ResetFocusEncoder Command  WO Resets the Focus encoder. 
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Iris 
 
Parameter Name Type Value Access Description 

IrisRequestedPositionRaw Integer Min: IrisMin2 
Max: IrisMax 

RW Sets raw iris absolute position. 

SetIrisPosition Command  WO Drives the iris to the absolute 
position value of 
IrisRequestedPositionRaw. 

CurrentFNumber Float  RO Returns the current f-number 
value of the lens iris. A Value of 
0.0 means the iris position is 
unknown 

OpenIrisFull Command  WO Opens the iris to the fully 
opened position. 

CloseIrisStep Command  WO Closes the iris by the amount 
defined in the IrisStepValue 
feature. 

OpenIrisStep Command  WO Opens the iris by the amount 
defined in the IrisStepValue 
feature. 

IrisStepValue Integer Min: 1 
Max: 127 

RW Sets the iris step to be used 
with OpenStep and CloseStep 
commands. 

GetIrisRange Command  WO Sends the Get Iris Range 
command to the camera. 

IrisMin Integer  RO Returns the minimum iris limit. 

IrisMax Integer  RO Returns the maximium iris limit. 

IrisRange Integer  RO Displays the limit values of the 
iris, after the GetIrisRange 
command issued. 
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Transport Layer Control 
The Transport Layer Control provides a variety of configuration settings and read-only 
information for configuring communications between the cameras and other devices with the  
10 GigE Vision interface. 
 
Parameter Name Type Value Access Description 

PayloadSize Integer  RO Provides the number of 
bytes transferred for each 
image on the stream 
channel, including any end-
of-line, end-of-frame 
statistics or other stamp 
data. 

 

GigEVision 
Parameter Name Type Value Access Description 

GevMACAddress Integer  RO Stores the MAC address of 
the given network interface. 

GevCurrentIPConfigurationLLA Boolean  RW Indicates if Link Local 
Address IP configuration 
scheme is activated on the 
given network interface. 

GevCurrentIPConfigurationDH
CP 

Boolean  RW Indicates if DHCP IP 
configuration scheme is 
activated on the given 
network interface. 

GevCurrentIPConfigurationPer
sistentIP 

Boolean  RW Indicates if PersistentIP 
configuration scheme is 
activated on the given 
network interface 

GevCurrentIPAddress Integer  RO Reports the IP address for 
the given network interface 
once it has been configured 

GevCurrentSubnetMask Integer  RO Provides the subnet mask of 
the given interface 

GevCurrentDefaultGateway Integer  RO Indicates the default 
gateway IP address to be 
used on the given network 
interface 

GevPersistentIPAddress Integer  RW Indicates the Persistent IP 
address for this network 
interface 
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Parameter Name Type Value Access Description 

GevPersistentSubnetMask Integer  RW This feature indicates the 
Persistent subnet mask 
associated with the 
Persistent IP address on this 
network interface. 

GevPersistentDefaultGateway Integer  RW Indicates the persistent 
default gateway for this 
network interface. 

GevLinkSpeed Integer  RO Indicates the speed of 
transmission negotiated by 
the given network interface 
in Mbps. 

GevCCP Enumeratio
n 

String 
OpenAccess 
ExclusiveAccess 
ControlAccess 

Num. 
0 
1 
2 

RO  

GevPrimaryApplicationSocket Integer  RO Indicates the UDP source 
port of the primary 
application. 

GevPrimaryApplicationIPAddr
ess 

Integer  RO Indicates the address of the 
primary application. 

GevMCPHostPort Integer  RW Controls the port to which 
the device must send 
messages. Setting this value 
to 0 closes the message 
channel. 

GevMCDA Integer  RW Controls the destination IP 
address for the message 
channel. 

GevMCTT Integer  RW Provides the message 
channel transmission 
timeout value in 
milliseconds. 

GevMCRC Integer  RW Controls the number of 
retransmissions allowed 
when a message channel 
message times out. 

GevMCSP Integer  RO Indicates the source port for 
the message channel 

GevSCCFGUnconditionalStrea
ming 

Boolean  RW Enables the camera to 
continue to stream, for this 
stream channel, if its control 
channel is closed or 
regardless of the reception 
of any ICMP messages (such 
as destination unreachable 
messages). 
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Parameter Name Type Value Access Description 

GevSCPHostPort Integer  RW Indicates the port to which 
the device must send data 
stream. 

GevSCPSFireTestPacket Boolean  RW When this bit is set, the 
device fires one test packet. 

GevSCPSDoNotFragment Boolean  RW This bit is copied into the do 
not fragment bit of the IP 
header of each stream 
packet. 

GevSCPD Integer  RW Indicates the delay (in 
timestamp counter unit) to 
insert between each packet 
for this stream channel. 

GevSCDA Integer  RW Indicates the destination IP 
address for this stream 
channel. 

GevSCPSPacketSize Integer Min: 72 
Max: 8164 

RW The stream packet size to 
send on this channel, except 
for data leader and data 
trailer; and the last data 
packet which might be of 
smaller size (since packet 
size is not necessarily a 
multiple of block size for 
stream channel). 

GevHeartbeatTimeout Integer Min: 500 
Max: 4294967295 

RW Indicates the current 
heartbeat timeout in 
milliseconds. 

GevTimestampTickFrequency Integer  RO This 64-bit feature indicates 
the number of timestamp 
ticks during 1 second. 

GevTimestampControlLatch Command  WO Latches current timestamp 
counter into Timestamp 
Value register. 

GevTimestampControlReset Command  WO Resets timestamp 64-bit 
counter to 0. 

GevTimestampValue Integer  RO Reports the latched 64-bit 
value of the timestamp 
counter. 
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User Set Control 
User Set Control allows you to save custom settings and reload them into the camera as needed. 
 
Parameter Name Type Value Access Description 

UserSetSelector Enumeration String 
Default 
UserSet0 
UserSet1 
UserSet2 
UserSet3 

Num. 
0 
1 
2 
3 
4 

RW Selects User Set to load, 
save, or configure. Default 
settings are configured by 
the factory and are write-
protected 

UserSetLoad Command   WO Loads User Set specified by 
UserSetSelector from non-
volatile memory into camera 
RAM and makes it active. 

UserSetSave Command   WO Saves User Set 0 ,1, 2 or 3 
specified by UserSetSelector 
to non-volatile memory. 

UserSetDefault Enumeration String 
Default 
UserSet0 
UserSet1 
UserSet2 
UserSet3 

Num. 
0 
1 
2 
3 
4 

RW Selects User Set to load and 
activate when a camera is 
powered on or reset. 
Default Configuration is set 
by the factory. 

 
 



Cheetah Pregius Camera with 10 GigE Vision Interface – User Manual  

 May 6, 2021 Page 64 of 181  Rev 1.1 

Configuring an Ethernet Adapter 
and Host Computer 

For the best system performance, configure the following parameters of your network interface 
card (NIC): Jumbo Frames (Jumbo Packets), Receive/Transmit Buffers, Interrupt Moderation Rate 
to the values shown below. You also might need to disable antivirus software and Firewalls, turn 
off power saving plan, and configure IP addresses for multiple NICs on the host computer. 
 
 

Make sure that the version of your NIC driver is the most 
recent one, update it if necessary. Using an outdated version 
of a NIC driver might negatively affect the data transmission. 
 

 
 

Parameter Value 
Jumbo Frames (or Jumbo Packets) 9000 (9014, 16K, or 9 KB MTU) 

Receive Buffers (or Receiver Descriptors) Maximum 

Transmit Buffers Maximum 

Interrupt Moderation  Enable 

Interrupt Moderation Rate (or Interrupt Throttling) Extreme 

 
For adjusting procedures, see the Adjusting Jumbo Frames, Receive/Transmit Buffers, and 
Interrupt Moderation Rate in Windows section. 
 
 

The parameter names and configuring procedures depend on the adapter 
model and manufacturer and may differ from the ones described in this 
chapter. When adjusting the adapter parameters, select the ones that relate 
to the parameters listed above. For more information, refer to the NIC 
documentation. 
 

 
  



Cheetah Pregius Camera with 10 GigE Vision Interface – User Manual  

 May 6, 2021 Page 65 of 181  Rev 1.1 

Jumbo Frames 
Jumbo Frames (or Jumbo Packets) parameter allows for payloads larger than the standard 
maximum transmission unit (MTU) of 1,500 bytes and supports up to 9,000 bytes per packet. 
Jumbo Frames are used to reduce the overhead load per packet, decrease CPU load, and 
increase data transfer rate. As fewer packets are needed to transfer data, the number of 
interrupts decreases resulting in lower overall CPU usage. 
 
Make sure that all network equipment (cameras, switches, routers, Network Interface Cards 
(NICs)) supports Jumbo frames and is configured to use the same frame size. If some network 
devices do not support Jumbo Frames, then packets and frame drops may occur.  

Most network adapters have Jumbo Packets disabled. To enable Jumbo Packet, please follow the 
steps in the Adjusting Jumbo Frames, Receive/Transmit Buffers, and Interrupt Moderation 
Rate in Windows section. 
 

Connect the Cheetah 10 GigE Vision camera to a dedicated Ethernet port and 
use an Ethernet adapter that supports Jumbo Packets.  

 
 

Receive/Transmit Buffers 
Receive Buffers (or Receive Descriptors) and Transmit Buffer parameters set the amount of 
system memory that can be used by the adapter driver when copying data to the memory. 
Typically, it is set to a low value by default (usually 256). This insufficient number of 
receive/transmit buffers leads to dropped packets (older packets will be overwritten).  
 
For maximum performance, set these parameters as high as possible.  
 
The maximum setting supports more packets, improves stability, and can be configured on the 
most systems without causing any system level interrupt. However, it can negatively affect servers 
which have limited system memory. 
 
 

Receive/Transmit Buffers settings do not affect your system’s CPU usage. 
 

 
 

The Receive Buffers can be set up to 2048 depending upon the RAM 
available. Make sure that the Transmit Buffers setting is double the Receive 
Buffers. Experiment with the settings until you achieve the best value 
appropriate for your system.  

 
  



Cheetah Pregius Camera with 10 GigE Vision Interface – User Manual  

 May 6, 2021 Page 66 of 181  Rev 1.1 

Interrupt Moderation Rate 
Interrupt Moderation Rate (or Interrupt Throttling) sets the maximum number of interrupts per 
second to the CPU when processing the transmitted and received packets. 
 
Minimizing the interval between interrupts reduces the latency on each packet but increases 
CPU usage and decreases throughput. To minimize CPU usage, larger interrupt intervals are 
required. 
 
Some NICs support only Interrupt Moderation control, while the others support both Interrupt 
Moderation and Interrupt Moderation Rate control. 
 
When the Interrupt Moderation setting is disabled, an interrupt is created for every packet, 
reducing the latency on each packet. However, this significantly increases CPU usage. Enabling 
the Interrupt Moderation setting allows multiple packets to be processed for each interrupt 
lowering CPU usage. 
 
 

The Interrupt Moderation Rate can be set at about 8,000 (or Extreme) 
interrupts per second to achieve lower latency.  
 
If some latency is acceptable, the Interrupt Moderation Rate can be set at 
about 1,000 (or Low) interrupts per second to achieve lower CPU usage. 
 
Experiment with your system to determine the optimal setting. You can try 
the following options as well:  

• Use the default value set by the manufacturer’s drivers. 

• Set a NIC to the adaptive interrupt moderation mode. In this mode, the 
interval is dynamically changed according to packet size and throughput.  
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Adjusting Jumbo Frames, Receive/Transmit 
Buffers, and Interrupt Moderation Rate in 
Windows 
 
1. Click Start icon → Windows System → Control Panel. 

 
2. Click Hardware and Sound → Devices and Printers → Device Manager. 
 
3. Expand Network Adapters list→ Right-click the Ethernet adapter that works with your 

camera → Properties. 
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4. On the Advanced tab, set the following parameters: 

• Jumbo Packet (or Jumbo Frame) → Set Value to 9014 Bytes (or 9 KB MTU, 9000, 16K – 
depends on NIC). 

• Receive Buffers (or Receive Descriptors) → Set to the maximum value possible. 

• Transmit Buffers → Set to the maximum value possible. 

• Interrupt Moderation → Enable. 

• Interrupt Moderation Rate (or Interrupt Throttling) → Set to Extreme. 
At higher data rates, the Extreme setting may improve system performance. At lower data rates, a 
Low setting is preferred since delayed interrupts cause additional latency. 
 

 
 

5. Click OK. The network connectivity may be lost for a couple of seconds. 
 

6. Reboot your PC to ensure that new settings have been activated. 
  

If Jumbo Packet or Jumbo 
Frame is absent from the 
list, your NIC does not 
support Jumbo Packets. 
Maximum camera 
performance cannot be 
achieved. 
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Configuring a Host Computer 
This section describes how to disable the  Windows Firewall, turn off the power saving plan, and 
configure IP addresses for multiple NICs on the host computer.  
 
Antivirus software, Firewalls, or third-party filter drivers may impact the efficiency of the system 
resulting an excessive number of dropped frames and slow video streaming. 
 
When too many frames have been dropped, the video acquisition rate slows down. The 
following pop-up window opens:  

 

 
 
 
Imperx recommends turning off any Firewalls, antivirus software, and third-party filter drivers and 
to disable Windows Performance Monitor (perfmon.exe) or Wireshark (use it solely for debugging 
purposes), and not opening the Networking tab in Windows Task Manager.  
 
To turn off the Firewall, please refer to the sections Disabling Windows Firewall for All 
Connections and Disabling Windows Firewall for Selected Network Adapters. 
 
Please contact your IT Department on turning off antivirus software and any third-party filter 
drivers. 
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Disabling Windows Firewall for All Connections 
1. Click Start icon → Windows System → Control Panel. 

 
2. Click System and Security → Windows Defender Firewall. 

 
3. On the left panel, click Turn Windows Defender Firewall on or off. The Customize settings 

windows opens. 
 

4. Select a network type that your camera is connected to, and click Turn off Windows 
Defender Firewall (not recommended). Click OK. 
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Disabling Windows Firewall for Selected Network Adapters 
1. Click Start icon → Windows System → Control Panel. 

 
2. Click System and Security → Windows Defender Firewall. 
 
3. On the left panel, click Advanced settings. The Windows Defender with Advanced Security 

windows opens. 
 
4. Click Windows Defender Firewall Properties. 

 
 

5. In the Windows Defender Firewall with Advanced Security on Local Computer Properties… 
window, select the tab of the profile to turn off the firewall and click Customize… in the State 
section.  
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6. The Protected Network Connections for the Private Profile windows shows a list of the 
network connections with the firewall turned on. To disable the firewall, uncheck those 
connections that contain your cameras. Click OK. 
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Multiple NICs in a Single Host PC 
When several NICs are installed in the same host PC, you have to assign a unique IP address to 
each NIC. You can use one of the following methods: 
 

Method When to use 
Configuring a static IP address In networks without a DHCP server 

Configuring a dynamic IP address via DHCP In networks with a DHCP server installed 

Link-Local IP Addressing In the absence or failure of static or dynamic address 
configuration 

 
 

Before assigning a dynamic IP address, please make sure that a DHCP server 
is installed in your network. The DHCP server assigns the IP address to each 
NIC with DHCP/Auto IP setting enabled.  
 
If the DHCP server is not installed in the network, manually assign static IP 
addresses to each NICs and GigE Vision cameras. 

 

Configuring a Static IP Address in Windows 
1. Click Start icon → Windows System → Control Panel. 

 
2. Click Network and Internet → Network and Sharing Center. 

 
3. On the left panel, click Change adapter settings. 

 
4. Right-click the Ethernet adapter that works with your camera → Properties. 

 
5. Select Internet Protocol Version 4 (TCP/IPv4), click Properties. 
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6. Select Use the following IP address and assign an IP address to the network adapter. The 
Default gateway field should be blank. 
 
Imperx recommends using a private network IP address. The following IPv4 address ranges 
are reserved for private networks: 
 

RFC1918 name IP address range Largest CIDR block (subnet mask) 

24-bit block 10.0.0.0–10.255.255.255 10.0.0.0/8 (255.0.0.0) 

20-bit block 172.16.0.0–172.31.255.255 172.16.0.0/12 (255.240.0.0) 

16-bit block 192.168.0.0–192.168.255.255 192.168.0.0/16 (255.255.0.0) 
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7. Click OK. 

 
8. Repeat steps 4–6 for each NIC on your computer. 
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Configuring a Dynamic IP Address via DHCP in Windows 
For a NIC to obtain an IP address automatically, follow the steps below. 
1. Click Start icon → Windows System → Control Panel. 

 
2. Click Network and Internet → Network and Sharing Center. 
 
3. On the left panel, click Change adapter settings. 
 
4. Right-click the Ethernet adapter that works with your camera → Properties. 
 
5. Select Internet Protocol Version 4 (TCP/IPv4), click Properties. 
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6. Make sure that Obtain an IP address automatically is enabled. 

 
 

 
 

The DHCP server assigns a dynamic IP address to the NIC. If the DHCP server 
is not available, a link-local address assingnment takes place. 

 

Link-Local IP Address 
A NIC assigns a link-local IP address automatically when a static IP address has not been 
configured and a DHCP is not enabled. This address is valid only for a local network and is not 
routable. 
 
The IPv4 address range is 169.254.0.0–169.254.255.255. 
 
When a static IP address or DHCP becomes available, a new IP address is assigned instead of the 
link-local address. 
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Configuring Power Management in Windows 
For applications with extended periods of image streaming, configuring power management is 
required. Typically, if there is no activity from the keyboard or mouse, the computer or NIC goes 
to sleep, and the image stream gets interrupted. To prevent Windows from powering down the 
NIC or computer, you need to change the power plan settings. 

To change power plan settings for the computer: 

1. Click Start icon → Windows System → Control Panel. 
 

2. Click Hardware and Sound → Power Options. 
 

3. Next to the power plan, click Change plan settings.  

 
 

4. In the Put the computer to sleep dropdown list select Never and click Save changes.  
Turn off display can be set to any value. 
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To change power plan settings for the NIC: 

1. Click Start icon → Windows System → Control Panel. 
 

2. Click Network and Internet → Network and Sharing Center. 
 

3. On the left panel, click Change adapter settings. 
 

4. Right-click the Ethernet adapter that works with your camera → Properties. 
 

5. Click Configure. Adapter Properties window opens. 
 

6. On the Power Management tab, uncheck the Allow the computer to turn off this device to 
save power option, click OK. 
 

7. Repeat steps 4–6 for each NIC. 
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Software GUI 

Overview 
The IpxPlayer software application provides a graphical user interface (GUI) with functionality for 
controlling Imperx camera parameters, acquiring video, showing acquired video, and saving 
acquired images or video on the host computer.  
 
The application also collects and displays statistical information on acquired images and generates 
a log of data transfers between the camera and the host computer. 

 

Supported Operating Systems 
The IpxPlayer is compatible with the following operating systems: 

• Windows 7, 32-bit and 64-bit 

• Windows 10, 32-bit and 64-bit 

• Ubuntu Linux 18.04 64-bit 

• Ubuntu Linux 18.04 64-bit, ARM CPU 

• Ubuntu Linux 20.04 64-bit 

Compatibility 
The IpxPlayer is compatible with the Imperx GigE Vision cameras. 
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User Interface and Functionality 
The IpxPlayer provides the following functionalities: 

• Detects camera. 

• Connects to the camera and will run multiple instances of applications. 

• Controls camera parameters (gain, exposure, trigger, white balance, and so on) using the 
GenICam node tree GUI. 

• Logs all protocol-related data (commands, images, events, and so on) transferred between 
the camera and host computer. 

• Shows live video from the selected camera. 

• Saves acquired video images or a series of images to a file. 

• Saves and loads camera configuration files. 

Installing the Software 
Use the installation wizard to install the Imperx Camera SDK software supplied with your camera. 
 
 

If a previous version of the GUI software is installed on your 
computer, you must remove it before completing the 
installation. The installation wizard will do this for you during 
the installation process. Or, you can uninstall a previous 
version yourself. 
 

 

To remove previous versions yourself: 
1. Open Control Panel on your computer. 

 
2. Select Programs and Features. 
 
3. Select the software from the list. 
 
4. Click Uninstall. 
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Installation 
1. Locate the executable file (IpxCameraSdk***.exe) on the media that shipped with 

your camera. 
 

2. Drag the file to your computer desktop. If a Security screen appears, click OK.  

 
 

3. Double click the executable file (IpxCameraSdk***.exe) on your desktop. The Welcome 
Setup screen opens. Note the recommendation to close other applications and click Next.  

 
 

4. When the License Agreement screen appears, read the agreement and click I Agree. 

 
5. On the Choose Components screen, select all the Cheetah Camera SDK components and click 

Next. 
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6. On the Choose Install Location screen, accept the default destination folder or click Browse 
and select a different location, click Next and then Install. 

 
 
The installer prompts you to uninstall any existing versions of the software from your computer before 
continuing the installation. 

 



Cheetah Pregius Camera with 10 GigE Vision Interface – User Manual  

 May 6, 2021 Page 84 of 181  Rev 1.1 

7. On the Installation Complete screen, select the check box to register your software and click 
Next. When the Imperx website appears, complete the Subscriber Registration and click 
Submit. 

 
 

8. On the Completing Imperx Camera SDK Setup screen, select Reboot now and click Finish. The 
Imperx IpxPlayer icon appears on your desktop. 
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Camera SDK 
The installation process places the Imperx camera SDK files on your computer’s hard drive using 
following structure: 
 
<InstallationFolder> – root SDK folder (usually, on the Windows OS, it is  
C:\Program Files\Imperx\Imperx Camera SDK\). 
 

 
 

<InstallationFolder> \bin\ – contains SDK binary executable files, including SDK dynamic libraries 
and IpxPlayer application executable 

<InstallationFolder> \Doc\ – contains SDK user manual files 

<InstallationFolder> \inc\ – contains SDK C++ header files 

<InstallationFolder> \lib\ – contains SDK C++ library files 

<InstallationFolder> \samples\ – contains SDK C++, C#, Python samples 

<InstallationFolder> \Drivers\ – contains kernel drivers for Imperx USB3 cameras 
  



Cheetah Pregius Camera with 10 GigE Vision Interface – User Manual  

 May 6, 2021 Page 86 of 181  Rev 1.1 

Connecting to Cameras 
1. Locate and open the IpxPlayer from your desktop. 

 
2. Click Camera menu and select Connect (or click the camera icon           ). 

The Select Camera dialog appears. The dialog lists all connected cameras. The version number refers to 
the installed Imperx GUI driver. 
 

3. Select a camera listed on the dialog.  
Camera information appears in the Device info section of the dialog.  
 

4. Click OK. If needed, click Rescan to update the list of cameras. 

  
 
 
 

The first time you attempt to connect to the camera, you might need to 
set the IP address if IP Subnet Mismatch appears highlighted in red and 
the OK button is not available.  
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To Set the IP Address: 

1. Click Set IP Address. 
 

2. When the Set IP Address screen appears, click OK. 
 
3. On the Select Camera screen, click OK. 
 
4. After the camera connects, click the play  icon on the IpxPlayer to begin capturing and 

displaying images. 
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Using the IpxPlayer 
The IpxPlayer displays and controls camera features and attributes based on an XML file stored 
in Flash memory inside the camera. The main window provides access to menus, shortcut icons, 
camera parameters, live images, capture options, a log, and camera statistics. You can customize 
the screen by closing, resizing, or hiding certain sections. Click Log at the bottom of the screen to 
see recent data transfers to or from the connected camera. 

Menu Bar 
The menu bar provides File, Camera, View, and Display options. Icons below the menu bar 
provide quick access to many of the menu bar functions. You can display an icon’s function by 
rolling the computer cursor over it. 

File Menu 
Load Configuration  

Opens the Open File dialog for loading a Camera 
Configuration file. 

Save Configuration 
 

Saves changes to an opened configuration file. 

Save Configuration As  Opens the Save File dialog for saving the Camera 
Configuration file with a user-specified file name. 

Exit 
 Closes the application. 

Camera Menu 
Connect 

 
Opens the Connection dialog for connecting to a camera. 

Disconnect 
 

Disconnects the camera. 

Camera Information 
 

Displays Camera Information including model, version, 
sensor type, firmware version, XML version, and so on. 

Play  Starts live video. 

Bandwidth testing  
Allows you to find the optimal Pixel Clock value for given 
USB3 interface bandwidth 

Stop  Stops live video. 

Record  
Toggles video recording start/stop on the computer’s hard 
drive. 

Snap  
Captures one image and saves it to the computer’s hard 
drive. 

View Menu 
GenICam Tree  Shows/hides the camera control GenICam tree panel. 

Log  
Shows/hides the camera control Log panel (Control, 
Stream, Events). 

Camera Terminal  Shows/hides the Camera Terminal panel. Use this panel for 
uploading Firmware Updates, LUT, FFC, DPC/HPC files or 
downloading LUT, FFC, DPC/HPC files. 

Capture  Shows/hides the Capture panel. 

Statistics  Shows/hides the Statistics panel. 
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Inspection View  

Opens a window showing a portion of the image. Use 
Inspection View sliders to reposition the view of your 
image. Drag to reposition the window. 

Histogram 
 

Shows/hides the Histogram panel.  

Hex Pixel Dump 
 

Shows/hides the Hex Pixel Dump panel. Use this panel for 
pixel analysis. 

 

Display Menu 
Zoom IN  

Increases the zoom by 25 percent around the center of the 
image when clicked. 

Zoom OUT  
Decreases the zoom by 25 percent around the center of the 
image when clicked. 

Actual Size (100%)  
Sets zoom to 1:1 in the center of the image. 

Fit to Window  
Scales the image to fit within the window height while 
maintaining aspect ratio. 

Spread to Window  
Scales the image width to fit across the display window 
while maintaining the image aspect ratio. 

Center Image  
Moves the center of the image to the center of display 
window. 

Saving and Loading Configurations 
The File menu provides a Save As function for configuration changes made in the camera 
parameters section of the screen. Saved configurations on the host computer have a file 
extension of .iccf. 
 
You can share these files with other users by email and other file transfer methods. You can load 
saved configurations into the IpxPlayer at any time.  

To save a configuration: 
1. Select the File menu. 

 
2. Select Save Configuration as. 
 
3. Navigate to location on your host computer. 
 
4. Create a file name. 
 
5. Click Save. 

To load a configuration: 
1. Select the File menu. 

 
2. Select Load Configuration. 
 
3. Navigate to the folder containing the file. 
 
4. Click Open. 
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Camera Parameters Panel 
The GenICam node tree displays the camera’s available configuration parameters. Use the 
Visibility drop-down to select an access level of Basic, Expert, or Guru. 

 
Basic  Provides visibility of all the basic features of the camera. 

Expert Provides visibility of advanced features of the camera that require a more in-depth 
knowledge of the camera functionality. This is the preferred visibility level for all 
advanced features in the cameras. 

Guru  Provides visibility of more advanced features that, if set incorrectly, might cause the 
camera to work improperly. 

Device Control Category 
The Device Controls parameters provide information about the camera. 
 
 

 
 

DeviceVendorName Imperx, Inc. 

DeviceModelName Full camera part number. 

DeviceVersion Camera Hardware version. 

DeviceManufactureInfo Technical support: 1-561-989-0006 
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DeviceSerialNumber Camera serial number. 

DeviceUserID User-defined camera name. 

DeviceSFNCVersionMajor The major version number of the GenICam Standard 
Features Naming Convention. 

DeviceSFNCVersionMinor The minor version number of the GenICam Standard 
Features Naming Convention. 

DeviceSFNCVersionSubMinor The sub major version number of the GenICam Standard 
Features Naming Convention. 

DeviceScanType Scan type of the sensor. 

DeviceReset Resets the entire camera, including communications. 

CameraHeadReset Resets only the image sensor to default. 

SensorTemperature Current sensor temperature. 

SensorBoardTemperature Current sensor board temperature. 

FPGATemperature Current FPGA temperature. 

FPGABoardTemperature Current FPGA board temperature. 

 

Temperature Control Category 
You to set the fan’s operation mode and the temperature at which the fan turns on in Auto 
mode. 
 

 
 
 
FanMode Selects the operation mode of the camera fan. 

FanOnTemperature Sets the temperature, in Celsius degrees, when the camera 
fan turns on to cool the camera (in Auto mode). Fan turns 
off when the internal camera temperature is 4 °C below 
the set temperature. 
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Version Info Category 
The camera contains non-volatile memory that stores manufacturing related information. The 
factory programs this information during the manufacturing process. 
 

 
 

SensorType Returns the CMOS sensor type: Bayer Color or Monochrome 

SensorModel Returns the CMOS sensor model. 

RgsID The camera’s register ID number. 

FirmwareImage The Firmware Image ID (F=Factory or A=Application). 

CameraHeadFirmwareVersion The Firmware version number. 

CameraHeadFirmwareBuild The Firmware build number. 

CustomerID The Customer ID for custom firmware (0=Imperx standard 
firmware). 

FamilyID The Family ID. 

XmlVersion The version of the XML file. 
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Image Format Control Category 
Provides information on the camera base resolution and output resolution. 
 

 
 
SensorWidth Effective width of the sensor in pixels. 

SensorHeight Effective height of the sensor in pixels. 

WidthMax Maximum width of the image in pixels calculated after horizontal binning, 
decimation, or any other functions change horizontal dimension of image. 

HeightMax Maximum height of image in pixels calculated after vertical binning, decimation, or 
any other functions change vertical dimension of image. 

Width Allows you to create an AOI: sets the output image width in number of pixels 
(multiples of 32). 

Height Allows you to create an AOI: sets the output image height in number of lines 
(multiples of 4). 

OffsetX AOI Offset in horizontal dimension: Enter the number of pixels to offset the image 
output from the left edge of the image. The number must be a multiple of 32. 

OffsetY AOI Offset in the vertical dimension: Enter the number of pixels to offset the 
image output from the top of the image. . The number must be a multiple of 4. 

PixelFormat The number of bits of memory associated with each pixel. Options are: Mono8, 
Mono10, Mono10Packed, Mono12, Mono12Packed, BayerGR8, BayerRG8, 
BayerGB8, BayerBG8, BayerGR10, BayerRG10, BayerGB10, BayerBG10, BayerGR12, 
BayerRG12, BayerGB12, BayerBG12, BayerGR10Packed, BayerRG10Packed, 
BayerGB10Packed, BayerBG10Packed, BayerGR12Packed, BayerRG12Packed, 
BayerGB12Packed, BayerBG12Packed. 
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PixelSize Number of bits per pixel in memory (8-, 10-, or 12-bits). 

PixelColorFilter Shows the color filter pattern. 

BinningVertical Sets number of rows to combine. 

BinningHorizontal Sets number of columns to combine. 

DecimationVertical Sets number of rows to skip. 

DecimationHorizontal Sets number of columns to skip. 

ReverseX Horizontally flips the image output. Any area of interest is applied 
after the flipping. The PixelFormat of color cameras changes 
automatically. 

ReverseY Vertically flips the image output. Any area of interest is applied after 
the flipping. The PixelFormat of color cameras changes automatically. 

TestPattern Enables test patterns based on the following selections: 
GreyHorizontalRamp, GreyVerticalRamp, 
GreyHorizontalRampMoving, GreyVerticalRampMoving, FlatField. 

SensorTestPattern Selects the type of test pattern that is generated by the camera 
image sensor. 

ADCBitDepth Returns which ADC bit depth is used. A higher ADC bit depth results 
in better image quality but slower maximum frame rate. 

SensorShutterMode Returns the shutter mode of the device. 
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Acquisition Control Category 
Acquisition Control determines the data flow between the camera and the computer. 
 

 
 

AcquisitionMode Supports three modes of acquiring images: SingleFrame, 
MultiFrame, and Continuous. 

AcquisitionStart Starts the acquisition of the device. 

AcquisitionStop Stops the acquisition of the device at the end of the current 
frame. 

AcquisitionAbort Aborts acquisition immediately, but a partially transferred image 
will be completed. If acquisition is not in progress, command is 
ignored. 

AcquisitionFrameCount Lets you enter the number of frames to acquire when using the 
MultiFrame Acquisition mode.  

ExposureMode Sets the operation mode of the exposure. Options are: Off, 
Triggerwidth, Timed (refer to the section Exposure Control for 
more information). 

ExposureTime Sets the exposure time in microseconds when ExposureMode is 
Timed and ExposureAuto is Off. 

ExposureAuto Sets the automatic exposure mode when ExposureMode is Timed. 
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AcquisitionFrameRateEnable Controls the acquisition frame rate/frame time. If this mode is 
On, you can extend frame time beyond the free-running frame 
time. 

AcquisitionFrameTime Allows you to set the actual frame time in microseconds. Changes 
to AcquisitionFrameTime affect the AcquisitionFrameRate setting. 

AcquisitionFrameRate Allows you to set the acquisition rate (in Hz with a precision of  
0.01 Hz) at which the frames are captured. Changes to 
AcquisitionFrameRate affect the AcquisitionFrameTime setting. 

AcquisitionLineTimeEnable Controls the acquisition line time. If this mode is On, you can 
extend line time beyond the free-running line time. 

AcquisitionLineTime This feature sets the actual line time in pixel clocks (74.25MHz). 

AcquisitionBurstFrameCount Sets the number of frames to acquire for each trigger. 

CurrentExposureTime This is a read-only feature providing a real-time monitor of the 
camera exposure time in micoseconds. 

CurrentFrameTime This is a read-only feature providing a real-time monitor of the 
camera output period in micoseconds. 

TriggerMode Enables or disables the triggering operation. A trigger initiates an 
exposure then readout sequence. Triggers received prior to 
completion of this sequence are ignored. 

TriggerSoftware The Start SW Trigger command instructs the camera to generate 
one short trigger pulse to capture and read out one frame when 
TriggerSource is set to Software.  

TriggerSource Specifies the internal signal or physical input line to use as trigger 
source. Options are Line1, Line2, PulseGenerator, and Software 
(Software is a single frame capture using internal exposure 
setting).  

TriggerActivation Sets the triggering edge to Rising or Falling. 

TriggerOverlap Sets trigger overlap mode to Off (default). If the camera receives 
a trigger pulse while the previous trigger is still being processed, 
the camera ignores this pulse. 

TriggerDebounceTime Sets the trigger signal de-bounce time. Subsequent trigger signals 
coming to the camera within the de-bounce time interval are 
ignored. 

TriggerFilterTime Specifies the minimum Trigger signal pulse width. Any pulse 
shorter than the selected time is ignored. 

TriggerDelay Sets the delay time in microseconds between the trigger pulse 
and the start of exposure. 
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Analog Control Category 
These parameters define analog and digital gain controls. 
 

 
 
Gain Sets analog/digital gain from 0 to 48 dB with 0.1 dB step.  

GainAuto Sets the automatic gain control (AGC) mode. ExposureMode can be set to 
Timed, PulseWidth, or Off. 

BlackLevel This represents a DC offset applied to the video signal. Values can range from 
0 to 4095. 

SensorBlackLevelRecommended Uses recommended value of BlackLevel from the sensor. 

BlackLevelAuto Automatically adjusts the black level based on measurements of the dark 
reference lines at the start of each frame. 

DigitalGain Sets digital gain from 1x to 4x. 

DigitalBlackLevel Controls the Digital Black Level for all taps. 

BalanceRatioSelector  Selects which color will be impacted by the BalanceRatio control. 

BalanceRatio Controls ratio of the selected color component to green, which is the 
reference color. 

BalanceWhiteAuto Controls the mode for automatic white balancing between the color 
channels. The white balancing color ratios are automatically adjusted by 
selecting either Once or Continuous. If Off, the White Balance color ratios 
are set manually using BalanceRatioSelector and BalanceRatio controls. 
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Auto Algorithm Control Category 
Auto Algorithm Control lets you configure settings for AWB (Automatic White Balance),  
AEC (Automatic Exposure Control), and AGC (Automatic Gain Control) algorithms. 
 
You can set the camera to AEC/AGC to keep the same image brightness during changing lighting 
conditions. On the Auto Algorithm Control panel, you can configure the range of exposure times 
and gain values for AEC/AGC by placing minimum and maximum limits on these parameters. 
 

 
 
BalanceWhiteAutoLowerLimit Controls the minimum value AWB can set for the Red/Blue 

BalanceRatio. 

BalanceWhiteAutoUpperLimit Controls the maximum value AWB can set for the Red/Blue 
BalanceRatio. 

BalanceWhiteAutoSpeed Sets the speed of AWB algorithm. 1 is slowest, 64 is fastest. 

ExposureAutoLowerLimit Sets the minimum exposure time value in microseconds. 
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ExposureAutoUpperLimit Sets the maximum exposure time value in microseconds. 

GainAutoLowerLimit Sets the minimum gain when GainAuto is Continuous (step is 0.1 
dB). 

GainAutoUpperLimit Sets the maximum gain (up to 48 dB in 0.1 dB steps). 

ExposureGainAutoPriority Selects whether to adjust gain or exposure first. 

ExposureGainAutoMode Shows what luminance mode is used during AGC or AEC. 

ExposureGainAutoTarget Sets the desired luminance level to be maintained during AGC or 
AEC or both assuming 12-bits per pixel. 

ExposureGainAutoTargetThreshold Sets the acceptable steady-state error of the luminance 
level to be maintained during AGC or AEC. Normal initial 
setting for stability is 16. 

AverageLuminosity Shows current average luminosity of the image. 

CurrentFrameCounterLow Shows number of frames captured since the camera power up 
(lower 32 bits). 

CurrentFrameCounterHigh Shows number of frames captured since the camera power up 
(upper 32-bits). 

 

Exposure Auto PID Coefficients Category 

 
 
ExposureAutoPMin Controls the minimum of the P coefficient for Exposure Auto control 

loop. 

ExposureAutoPMax Controls the maximum of the P coefficient for Exposure Auto control 
loop. 

ExposureAutoExposureForPMax Maps the maximum of the P coefficient to the value of 
exposure in the Exposure Auto control loop. 

 

Gain Auto PID Coefficients Category 
 

 
 
GainAutoPcoef Controls the P coefficient for Gain Auto control loop. 

GainAutoIcoef Controls the I coefficient for Gain Auto control loop. 

GainAutoDcoef Controls the D coefficient for Gain Auto control loop. 
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Data Correction Category 
These parameters enable data correction and image improvements with Look-up tables and file 
corrections. 
 

 
 

LUTEnable Selects LUT to be used in processing image (LUT1 – LUT4). LUT1 and 
LUT3 are pre-programmed with Gamma 0.45, LUT2 and LUT 4 are 
preprogrammed with negative LUT. 

FFCEnable Selects FFC to be used in processing image. FactoryFFC has a factory 
preset correction. You can create and load your FFC to FFC1–FFC7. 

DefectPixelCorrection Enables defect pixel correction. You can upload your own defect pixel 
map. 

DefectPixelCorrectionMode Controls the method used for replacing defective pixels. 

BadPixelCorrection Enables Hot Pixel Correction. You can upload your own hot pixel map. 

BadPixelCorrectionMode Controls the method used for replacing hot pixels. 

DefectPixelCountMax Maximum number of pixels in the Defect Pixel Correction Table. 

BadPixelCountMax Maximum number of pixels in the Hot Pixel Correction Table. 
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Digital IO Control Category 
These controls enable you to map camera’s inputs and outputs and configure strobes. 
 

 
 

LineSelector Selects the physical line (or pin) of the external camera connector or the virtual 
line of the Transport Layer to configure. 

LineMode Returns the status of the physical line used to input or output a signal. 

LineInverter Controls the inversion of the signal of the selected input or output line. 

LineStatus Returns the current signal level on the selected input or output line. 

LineSource Maps the camera’s internal signals to the respective Output. The signals are: 
ExposureStart, ExposureEnd, MidExposure, ExposureActive, TriggerActual, 
TriggerDelayed, PulseGenerator, Strobe1, Strobe2. 

LineFormat Returns the current electrical format of the selected physical input or output 
line. 

Strobe1Reference / Strobe2Reference Sets the reference event for the strobe signal. 

Strobe1Enable / Strobe2Enable Enables or disables the strobe. 

Strobe1Width / Strobe2Width Sets the strobe pulse duration in microseconds. 

Strobe1Delay / Strobe2Delay Sets the strobe delay from the reference in microseconds. 
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Pulse Generator Category 
The Pulse Generator provides a signal generator for camera sourced trigger or control signals. 
 

 
 
PulseGenGranularity Sets the Pulse Generator main timing resolution. The x1 resolution is in 

microseconds. The following four granularity steps are possible: x1, x10, 
x100, x1000 (x1000 is equal to 1 ms timing resolution). 

PulseGenWidth Sets the value of the pulse width in microseconds. 

PulseGenPeriod Sets the value of the pulse period in microseconds. 

PulseGenNumPulses Sets the number of pulses generated by the Pulse Generator. To set 
Pulse Generator in continuous mode, set the parameter in 65536. 

PulseGenMode Sets the mode of the Pulse Generator. 

PulseGenEnable Enables the Pulse Generator. 
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Canon Lens Control Category 
If using Canon EF Active lens mount, the following parameters are available for controlling the 
lens or checking its status. Please refer to the Canon Lens Control section for more information 
on lens adjusting procedures. 

Controller Settings Category 

 
 
InitLens Initializes the Canon Lens, if one is mounted to the camera. Always 

execute the InitLens command upon powering up. 

StopLens Removes the power from the Iris drive. Run InitLens command to resume 
the lens control. 

LensControllerStatus Shows status of Canon Lens initialization. 

LensAF_MF Shows status of Auto / manual focus switch located on the lens. 

GetLensID Request the value of the Lens ID register. 

LensID Returns the Lens ID after the GetLensID command is issued 
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Focus Category 

 
 

NearFull Drives the focus to the fully Near position. 

FarFull Drives the focus to the fully Far position. 

FocusStepValue Sets the focus step size for NearStep and FarStep focus. A typical step 
size has a value of 4. 

NearStep Drives the focus toward the Near direction based on the amount 
defined in the FocusStepValue feature. 

FarStep Drives the focus toward the Far direction based on amount defined in 
the FocusStepValue feature. 

FocusReqPosition Sets the desired focus value to use with SetFocusPosition command. 

SetFocusPosition Drives the focus to the absolute position defined in the 
FocusReqPosition feature. 

FocusMax Returns maximum focus encoder limit. 

FocusSetMax Sets the maximum focus encoder limit by copying current encoder 
value  

FocusEncoderStatus Shows the current focus encoder value after issuing the 
GetFocusEncoderStatus command. 

GetFocusEncoderStatus Requests the focus encoder position value. 

Reset Focus Encoder Resets the Focus encoder. 
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Iris Category 

 
 

IrisRequestedPositionRaw Sets raw iris absolute position. 

SetIrisPosition Drives the iris to the absolute position value of 
IrisRequestedPositionRaw. 

CurrentFNumber F-number value of the lens iris. Value of 0.0 signals an unknown iris 
position. 

OpenIrisFull Fully opens the iris. 

CloseIrisStep Closes the iris based on amount entered in the IrisStepValue feature. 

OpenIrisStep Opens the iris by the amount defined in the IrisStepValue feature. 

IrisStepValue Sets the iris step size (between 1 and 127) when using the OpenIrisStep 
and CloseIrisStep commands. 

GetIrisRange Determines the Iris Range. The values are read using the GetIrisRange 
command. 

IrisMin Returns the minimum iris limit. 

IrisMax Returns the maximum iris limit. 

IrisRange Shows the limit values of the iris after issuing the GetIrisRange 
command. 
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Transport Layer Control Category 
The Transport Layer controls the exchange of data between the camera and the host computer. 
 

 
 

PayloadSize Provides the number of bytes transferred for each image on the stream 
channel, including any end-of-line, end-of-frame statistics, or other 
stamp data. 

GevMACAddress Displays the MAC address of the Ethernet network interface. 

GevCurrentIPConfigurationLLA Indicates whether a Link Local Address IP configuration 
scheme is activated on the network interface. 
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GevCurrentIPConfigurationDHCP Indicates whether a DHCP IP configuration scheme is 
activated on the network interface. 

GevCurrentIPConfigurationPersistentIP Indicates whether a Persistent IP configuration scheme 
is activated on the network interface. A persistent IP 
address is hard-coded in non-volatile memory. 

GevCurrentIPAddress Displays the host computer’s network IP Address. 

GevCurrentSubnetMask Displays the subnet mask of the interface. 

GevCurrentDefaultGateway Displays the default gateway IP address to be used on the 
network interface. 

GevPersistentIPAddress Indicates the Persistent IP address for the network interface. 
The persistent IP address is re-used by the camera on power-up 
when Persistent IP is enabled. 

GevPersistentSubnetMask Indicates the Persistent subnet mask associated with the 
Persistent IP address on the network interface. 

GevPersistentDefaultGateway Indicates the Persistent default gateway for the network 
interface. 

GevLinkSpeed Indicates the speed of transmission negotiated by network interface in 
Mbps. 

GevCCP Enables granting privilege to an application. Options are open access, 
exclusive access, or control access. 

GevPrimary Application Socket Indicates the UDP source port of the primary application. 

GevPrimary Application IP Address Indicates the address of the primary application. 

GevMCPHostPort Controls the port to which the device must send messages. Setting this 
value to 0 closes the message channel. 

GevMCDA Controls the destination IP address for the message channel. 

GevMCTT Provides the message channel transmission timeout value in 
milliseconds. 

GevMCRC Controls the number of retransmissions allowed when a message 
channel message times out. 

GevMCSP Indicates the source port for the message channel. 

GevSCCFG UnconditionalStreaming Enables the camera to continue to stream for this stream 
channel if its control channel is closed or regardless of the 
reception of any ICMP messages (such as destination 
unreachable messages). 

GevSCPHostPort Indicates the port to which the device must send data stream. 

GevSCPSFireTestPacket When this bit is set, the device will fire one test packet. 

GevSCPSDoNotFragment This bit is copied into the "do not fragment" bit of IP header of 
each stream packet. 

GevSCPD Indicates the delay (in timestamp counter unit) to insert between each 
packet for this stream channel. 

GevSCDA Indicates the destination IP address for this stream channel. 
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GevSCPSPacketSize The stream packet size to send on this channel, except for data leader 
and data trailer, and the last data packet that might be of smaller size 
(since packet size is not necessarily a multiple of block size for stream 
channel). 

GevHeartbeatTimeout Indicates the current heartbeat timeout in milliseconds. 

GevTimestampTickFrequency This 64-bit feature indicates the number of timestamp ticks 
during 1 second. 

GevTimestampControlLatch Latches current timestamp counter into "Timestamp value" 
register. 

GevTimestampControlReset Resets timestamp 64-bit counter to 0. 

GevTimestampValue Reports the latched 64-bit value of the timestamp counter 

User Set Control Category 
 

 
 

UserSetSelector Points to User Configuration Set (Default, User Set 0…User Set 3) to load 
into the camera or save into the camera’s non-volatile memory. Default is 
the Factory Default Settings. 

UserSetLoad Loads the User Set specified by UserSetSelector into the camera 
workspace (volatile).  

UserSetSave Saves the User Configuration Set 0, 1, 2, or 3 specified by UserSetSelector 
to the camera’s non-volatile memory. The Default User Set is read only 
and cannot be modified by the user. 

UserSetDefault Points to User Configuration Set, which will be loaded and made active 
when the device is reset or after power is applied. 
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Capture Panel 
The Capture panel provides options for recording images and video and saving them to the 
computer hard drive. Click the Capture tab at the bottom of the IpxPlayer screen to access the 
panel. 
 

 

Recording Acquired Images 
Use the Recording section of the Capture screen to record snapped images or video images. The 
screen displays real-time capture information during recording. 

Snap  Saves the current image to the hard drive. 

Record Starts or stops saving video to the hard drive. 

Statistics Shows the number of frames acquired, saved, and dropped during the current 
capture session. Dropped frames are frames received from the camera but not 
transferred due to a lack of host buffers. 

Buffer Queue Filling  Shows the current filling status of the capture frames queue. 

Saving Image Output 
The Output section of the Capture screen lets you configure the location and format of saved 
images in the computer. 

Output Location  You determine where to save files on the computer. 

File Name  Defines the file name template. 

File Format  Allows you to specify the output file format from a drop-down list. 
• RAW File. This is an unprocessed file format. 
• BMP Image. (8-bpp BMP for grayscale, 24-bpp for Color images) 
• JPG Image. You can adjust the image quality. Default is 85%. 
• TIFF Image. Normalized option affects pixel intensity values. 
• AVI Movie. Options are – you can set the frames per second or get the 

current frames per second from the camera (see the Saving Image in AVI 
Movie File Format section). 
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Saving Image in AVI Movie File Format 
When saving images in AVI Movie format, follow the steps below: 
1. In the File Format drop-down list, select AVI Movie. 

 
2. In the Codec drop-down list, select a compression method—MPEG 4 or Uncompressed. 
 
3. In the FPS field, enter a desired value of the frame rate or click Cam.FPS to get the current 

frames per second from the camera. 
 

 
 
4. Click Options. 

The Movie Options Dialog screen appears. 
 

5. If pixel format of the images is 8-bit per pixel and the AVI file is to be viewed in Windows OS, 
check the Add Palette checkbox to add a palette to 8-bit bitmap image. 

 

 
 

6. Make sure that a value of the Ticks per second parameter matches the value of the 
GevTimestampTickFrequency parameter. 
 

7. Set minimum and maximum quantizers and click OK. 
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Log Panel 
The Log panel shows data transfers to or from the connected camera. Log information provides a 
numeric identifier assigned by the application, the transfer time, the control channel, and the 
message. Click the Log tab at the bottom of the IpxPlayer screen to access the panel. 
 

 
 

Channels to Log 
The Enable Logging check box initiates logging. You can save current log data to a TXT file (.txt) 
with space-separated fields.  
 
You must select a channel to log. Channels are device channels linked to an appropriate camera 
interface. The following options are available: 

Control Channel This is a data interface linked to the camera's Device Control Channel. The 
Control Channel is dedicated to camera parameters control. It sends and 
receives the data displayed on the Camera Parameters panel. The Control 
Channel is bi-directional, enabling data transfers from the host computer to 
the camera or from the camera to the host computer. 

Stream Channel This links to the camera's Device Stream Channel. The Stream Channel is 
dedicated to transferring video data from the camera to the host computer. 

Event Channel This links to the camera's Device Event Channel. The Event Channel notifies 
the host computer software about any events on the camera side. For 
example, the camera can notify the software that it received the trigger 
signal. 
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Statistics Panel 
The Statistics panel displays camera performance and other information based on settings and 
parameters. 

 
 

Frames acquired  The number of frames acquired after you click the Play button. 

Timestamp [ns]  The current value of the timestamp in the acquired image in nanoseconds. 

Current Block ID  The current value of the block ID in the acquired image. 

Frames dropped  The number of frames dropped by the camera (calculated from 
consequence block IDs). 

FPS    The number of frames per second. 

Throughput [MB/s] The average throughput value of the camera interface in megabytes per 
second. 
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Camera Terminal Panel 
The Camera Terminal panel lets you upload and download any custom files―DPM, HPM, Flat 
Field Correction (FFC), or Lookup Tables (LUT). It also allows you to upload Firmware updates. 
 

 

Uploading Files 
To upload DPM, HPM, FFC, or LUT files from the camera, follow the steps below. 
 
1. On the Upload tab, click Browse and navigate to a file (ZIP, RGS, DPM, HPM, FFC, or LUT). 
 
2. Select the file you want to upload. 
 
3. Select a Target location for the file. 

 
4. Click Upload…. 

Reboot the camera and restart the IpxPlayer for the changes to take into effect. 

Downloading Files 
To download DPM, HPM, FFC, or LUT files into the camera, follow the steps below. 
 
1. On the Download tab, select a Location from which to download a file. 
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2. Click Download…. 

A readout begins. 
 

3. Upon completing the readout, click Save. 
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Histogram Panel 
The Histogram panel shows pixel values in ADU.  
 

 

Mean/StdDev Pane 
• X Limits  Enables/disables X axis scale adjustments.  

By default, the pixel values are shown within 0–255 ADU. To change the 
limits, check the X Limits check box and select a coefficient (1–10). The 
new X axis limits are: 
 
Max. limit = Mean + SdtDev x coefficient. 
 
Min. limit = Mean – StdDev x coefficient. 

• Mean  Shows the mean pixel value (in ADU) 
• StdDev   Shows the standard deviation of pixel values (in ADU) 
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Visualization Pane 
The Visualization pane allows you to set a histogram type and select a row or column for 
displaying pixel values. 
 
Mode sets a visualization mode. 

 
 

• Bar histogram  Shows pixels’ values in ADU and the number of pixels of a certain value. 

• Row histogram    Shows pixels’ values in ADU in the selected row. 
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• Column histogram  Shows pixels’ values in ADU in the selected column. 

 
 
Row/Column selects a row/column coordinate to use in calculation. 
Set the visualization Mode to Row histogram or Column histogram and select a row/column 
coordinate. 
 
Average when checked, shows average pixels’ values in the selected row/column. 
 
Y Log when checked, a logarithmic Y axis is enabled. 
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Hex Pixel Dump Panel 
The Hex Pixel Dump panel shows pixel values in the table in hex format. The active area is 
highlighted with a yellow frame on the display.  
 
 

 
 
 
 
The pixel value is shown in RGB values for color images, and in Y (luminosity) values for 
monochrome image.  
 
For the Hex pixel Dump to display the pixel values correctly, set the Hex Pixel Dump data 
parameter in the menu File > Settings with respect to the pixel format as shown below. 
 
 Pixel Format 

 Packed Unpacked 

Hex Pixel Dump data Processed Either RAW 
or Processed 

 
 
 

image row numbers 

image column numbers 
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Camera Features 

Image Data Flow 
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Exposure Control 
The camera provides three exposure control modes—Off, Timed, and Trigger Width.  

In the Timed mode, you can control exposure time manually or automatically. To enable manual 
control, set ExposureAuto to Off and specify the exposure time using the ExposureTime setting. 

To enable AEC (Automatic Exposure Control), set ExposureAuto to Once or Continuous. Please 
refer to the section Automatic Exposure and Gain Control for more information on AEC. 

The camera works either in trigger (Standard or Fast Trigger) or free-running (untriggered) mode, 
you might need to also adjust trigger parameters when setting exposure (refer to the section 
Camera Triggering for more information on trigger parameters). 
 
 

The AEC is not available when exposure mode is set to Trigger Width. 
 

Exposure Control in Free-Running Mode 
In free-running mode, the camera constantly reads out the sensor, and the exposure time is 
determined by the frame readout time. The exposure time equals the frame read out time when 
the exposure mode is set to Off.  

 

Exposure time Exposure N Exposure N+1

Readout N-1 Readout NReadout time

Exposure time

Readout time

Settings:
Exposure Mode: Off
Trigger Mode: Off

Start of 
Exposure

Free-running mode, Exposure control is Off
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To reduce the image exposure time under bright lighting conditions, set the exposure control 
mode to Timed. The electronic exposure control does not affect the frame rate; it only changes 
the exposure time. When the Timed mode is active, the camera controls the start of exposure, so 
the new exposure ends just as the readout of the current frame ends and the readout of the next 
frame begins. 

Exposure time Exposure N Exposure N+1

Readout N-1 Readout NReadout time

Exposure time

Readout time

Settings:
Exposure Mode: Timed
Trigger Mode: Off
Exposure Time: User-specified (Min.= 36 µs; Max = Readout time)

Start of 
Exposure

Free-running mode, Exposure control is Timed

 
To configure the camera to work in free-running mode with Timed expose control: 

1. Turn off the camera image acquisition. 
 

2. Set ExposureAuto to Off for manual exposure control, or to either Once or Continuous for 
automatic exposure control. 
 

3. In the Acquisition Control menu: 
• Set TriggerMode to Off. 

 
• Set ExposureMode to Timed. 

 
• If ExposureAuto is Off, then set ExposureTime (in microseconds) to a user-specified value.  

 

In free-running mode, the maximum exposure time equals frame 
time. You can extend the exposure time by increasing the frame 
time: 

1. Check AcquisitionFrameRateEnable box. 

2. Increase the frame time by using AcquisitionFrameTime (in 
µs) or AcquisitionFrameRate (in Hz) settings. 

3. Set ExposureTime within the extended frame time range. 
 
In free-running mode, the minimum exposure is 36 µs.  
 
While the ExposureTime allows for 1-µs increments, the 
CurrentExposureTime increment equals 1-line time in µs. 
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Exposure Control in Trigger Mode 
In trigger mode, you can synchronize the camera’s acquisition cycle to an external signal by 
setting the exposure control to either Timed or Trigger Width. Trigger mode can be set to either 
Standard or Fast (see Camera Triggering). 

 
 

The electronic exposure control does not affect the camera’s frame rate in 
Fast trigger mode, because the exposure and readout operations are 
overlapped in time. In Standard Trigger mode, the maximum frame rate 
depends upon the exposure time, because the exposure and readout occur 
sequentially (not overlapped). 

 
 
In Timed exposure control mode, you can set the external trigger pulse to control the start of 
exposure. 

1. Turn off the camera image acquisition. 
 

2. Set ExposureAuto to Off for manual exposure control, or to either Once or Continuous for 
automatic exposure control.  
 

3. In the Acquisition Control menu: 
• Set TriggerMode to On. 

 
• Set ExposureMode to Timed. 

 
• If ExposureAuto is Off, then set ExposureTime (in µs) to a user-specified value.  

 
While the ExposureTime allows for 1-µs increments, the 
CurrentExposureTime increment equals 1-line time in µs. 

 
 

4. Configure the trigger parameters.  
Please refer to the section Configuring the Trigger, steps 3–6. 

 
In Trigger Width mode, you can set the external trigger signal to control the start and duration of 
exposure. This mode is available in both Standard and Fast trigger modes (refer to the section 
Trigger Modes).  
 
To configure the camera to work in Trigger Width Exposure mode: 

1. Turn off the camera image acquisition. 
 

2. Make sure that ExposureAuto is Off and AcquisitionFrameRateEnable is False. 
3. In the Acquisition Control menu: 

• Set TriggerMode to On. 
 

• Set ExposureMode to TriggerWidth. 
 

4. Configure the trigger pulse parameters.  
Please refer to the section Configuring the Trigger, steps 3–6. 
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In Standard Trigger mode, the maximum exposure time is defined by the 
formula: 

Exposure Time (max) = Trigger Period – Readout Time, 

where the Readout Time is equal to the CurrentFrameTime (in free-running 
mode, with AcquisitionFrameRateEnable off). 
 
In Standard trigger mode, the minimum exposure is equal to 1 line time. This 
value depends on a sensor model and some other parameters such as 
PixelFormat. 
 
In Fast Trigger mode, the maximum exposure time is 16 s. 

 

Global Shutter 
In global shutter mode, all pixels in the array reset at the same time, then collect signal during 
the exposure time, and finally transfer the image to a pixel memory region within each pixel. 
After transferring the image to the pixel memory region, the readout of the array begins. In this 
way, all pixels capture the image during the same period, which reduces any image artifacts due 
to motion within the scene. The maximum exposure is frame-time dependent, and the minimum 
exposure varies based on the image sensor. 

The camera overlaps the exposure and read-out times in free-running and Fast Trigger modes as 
shown in the following figure. 
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Automatic Exposure and Gain Control 
Automatic exposure control (AEC) and automatic gain control (AGC) enable the camera to 
maintain the same image brightness during the changing lighting conditions. You can enable 
both AEC and AGC independently or together by setting ExposureAuto and GainAuto to either 
Once or Continuous.  

AEC/AGC Mode Description 

Off AEC/AGC is disabled and a manual control is on. The camera applies the exposure 
time and gain you enter using the ExposureTime and Gain controls. 

Once Exposure duration/gain is adapted once by the camera. Once it has converged, it 
returns to the Off state; and the exposure and gains determined during the Once 
process are maintained until changed manually. 

Continuous Exposure duration/gain is constantly adapted by the camera to maximize the 
dynamic range. 

When AEC / AGC are in Continuous or Once mode, you can set the image luminance (brightness) 
target (ExposureGainAutoTarget), and the camera adjusts the exposure and/or gain accordingly. 
The luminance target is a 12-bit value (4095 is a max. value). To determine the luminance target 
when using 8-bits per pixel, take the desired output in ADUs and multiply this value by 16. The 
target luminance is the average luminance within the image. 
 
Also, for the Once mode, you can set an acceptable difference between the target and current 
image luminance (ExposureGainAutoTargetThreshold) in the range from 0 to 4095. When the 
threshold is reached, the camera turns off AEC/AGC algorithms and enables manual control over 
exposure duration and/or gain. 
 
 

In some rapidly changing and bright light conditions, an image 
brightness oscillation (image intensity flipping from bright to 
dark) could occur. To prevent this, increase the AEC minimum 
exposure setting, increase the target luminance level and/or 
decrease the lens iris. 

 
 

Initial conditions for AEC and AGC algorithms: 
Exposure and gain are set to the user-specified values of the ExposureTime and Gain controls. 
 
When AEC and AGC are enabled together, you might need to select whether to adjust gain or 
exposure first using ExposureGainAutoPriority control. 
 
• If the exposure priority is selected (ExposureTime), the camera adjusts the exposure first 

within the user-specified minimum/maximum limits. If one of the limits is reached before 
the target image luminance (or threshold) is achieved, then gain is applied. The camera 
varies the gain until either the target image luminance (or threshold) is reached or one of 
gain limits is reached. 
 

• If the gain priority is selected (Gain), the camera adjusts the gain first within the user-
specified minimum/maximum limits. If one of the limits is reached before the target image 



Cheetah Pregius Camera with 10 GigE Vision Interface – User Manual  

 May 6, 2021 Page 125 of 181  Rev 1.1 

luminance (or threshold) is achieved, the exposure is applied. The camera varies the 
exposure until either the target image luminance (or threshold) is reached or one of 
exposure limits is reached. 

By default, the ExposureGainAutoPriority control are set to ExposureTime. 
 
The AEC and AGC algorithms sample all pixels for the entire frame. The camera displays the 
current luminance within the frame. 
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P, I, and D Coefficients 
The P (Proportional), I (Integral), and D (Derivative) coefficients of PID feed-back control loops 
determine speed and stability of AEC and AGC algorithms.  
 
A PID controller continuously calculates a difference (an error) between a setpoint (SP)— 
ExposureGainAutoTarget— and a process variable (PV)—AverageLuminosity. Based on the sum 
of proportional, integral, and derivative responses, the controller determines an output value 
and adjusts exposure or gain to minimize the error. The PID controller continuously varies the 
output value until the luminance reaches the setpoint. 
 

setpoint
(ExposureGainAutoTarget)

PID

image sensorprocess variable
(AverageLuminosity) AEC/AGC

feedback output value u(t)

 y(t)

 
 
 
The AGC algorithm uses all three responses with a manual control available over the P, I, and D 
coefficients. 
 

setpoint
(ExposureGainAutoTarget)

Pcoef  x e(t) 

feedback y(t) output value u(t)∑ - +

Dcoef x (en-1 – en) 

∑ 
+

error e(t) +
+

 
 
The AEC algorithm uses only two responses – proportional and derivative with a manual control 
available over the P coefficient only. 
 

AEC/AGC PID coefficients controls 

AEC P varies depending on exposure 
I = 0 
D = P/2 

AGC P, I, and D are fixed values 

 

Icoef x ∑ e𝑛𝑛
𝑖𝑖=1 n 

Pcoef x en 

Dcoef x (en-1 - en) 

error en 
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Proportional Response 
The proportional response is a difference (error) between the setpoint and the process variable. 
This error is then multiplied by the proportional coefficient P. 
 

Increasing the P coefficient increases the speed of the control algorithm and 
degrades its stability. If the P coefficient is too high, the image luminance 
begins to oscillate. With further increase of the P coefficient, the oscillations 
become larger, and the system becomes unstable and may even oscillate out 
of control. 

 
 
The AEC algorithm uses an adaptive P coefficient.  

P coefficient

Exposure
time, µs36 µs ExposureAutoExposureForPMax

(25 ms by default )

ExposureAutoPMax
(8.00 by default)

ExposureAutoPMin
(0.04 by default)

 
The PID controller applies the P coefficient calculated on the previous iteration, computes the 
error, and adjusts exposure. The controller then re-calculates the P coefficient and applies the 
new value in the next iteration. 

Integral Response 
The integral response is the sum of the calculated errors over time multiplied by the integral 
coefficient I. 
  

Increasing the I coefficient decreases the speed of the control algorithm and 
degrades its stability. 
 

Derivative response 
The derivative response is the difference between the error found on the previous sample and 
the current error multiplied by the derivative coefficient D. The derivative response is sensitive 
to noise in the process variable signal. use very small derivative time 
 

Increasing the D coefficient increases the speed of the control algorithm and 
improves its stability. 
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We do not recommend changing P, I, and D coefficients. 
Changing the coefficients may cause oscillations and 
destabilize the system.  
 
If you need to change the coefficients, please contact Imperx 
support. 

 
 
Imperx sets up optimal P, I, and D coefficients to balance the speed and stability of AEC and AGC 
algorithms. 
 

XML Parameter Default value 

For AEC algorithm:   

ExposureAutoPMin 0.04 

ExposureAutoPMax 8.00 

ExposureAutoExposureForPMax 25,000 microseconds 

For AGC algorithm:  

GainAutoPcoef 0.06 

GainAutoIcoef 0.00 

GainAutoDcoef 0.03 

 

Camera Triggering 
Use the Trigger mode control to synchronize the camera to an external event and acquire an 
image at a specific time. A trigger pulse is issued when the external event occurs. The camera 
then receives the trigger and acquires the images. 

You can set the number of frames to acquire for each trigger using AcquisitionBurstFrameCount 
control. By default, AcquisitionBurstFrameCount is equal to 1 frame. The maximum number of 
frames is 65535. 

Trigger Modes 
The camera supports Standard and Fast Trigger modes. For the camera to work in the Standard 
Trigger mode, set TriggerOverlap parameter to Off. For the camera to work in the Fast Trigger 
mode, set TriggerOverlap parameter to ReadOut. 
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Standard Trigger Mode 
In Standard Trigger mode, the camera first performs the exposure and then reads out the image. 
An external timing pulse controls the start of the exposure if exposure control mode is set to 
Timed.  

Trigger

Exposure time Exposure N Exposure N+1

N N+1

Readout N Readout N+1Readout time

IgnoredIgnored

Trigger period

GenICam controls
TriggerMode: On
TriggerOverlap: Off
TriggerSource: Line 1 (or Line2, Software, Pulse Generator)
TriggerActivation: Rising Edge (or Falling Edge)
TriggerFilterTime, TriggerDelay, TriggerDebounceTime: – set if applicable.
Exposure Mode: Timed
For manual exposure control:
Exposure Time: User-specified (Min.= 36 µs; Max = Readout time)
ExposureAuto: Off
For automatic exposure control (AEC):
ExposureAuto: Continuous (or Once)

Parameters of the external trigger pulse 
Trigger width: ≥ 10 µs
Trigger period (min) = Exposure time (max) + Readout time

Start of 
Exposure

Standard trigger mode, Exposure control is Timed

Trigger active 
edge – Rising

Trigger
width

Exposure time
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Setting exposure control mode to Trigger Width allows the external timing pulse to control the 
exposure duration. 
 

Trigger

Exposure time
Exposure N Exposure N+1

N N+1

Readout N Readout N+1Readout time

Ignored

Trigger period

GenICam controls
TriggerMode: On
TriggerOverlap: Off
TriggerSource: Line 1 (or Line2, Pulse Generator)
TriggerActivation: Rising Edge (or Falling Edge)
TriggerFilterTime, TriggerDelay, TriggerDebounceTime: set if applicable
ExposureMode: Trigger Width

Parameters of the external trigger pulse 
Trigger width: ≥ 10 µs
Trigger period (min) = Exposure time (max) + Readout time

Standard trigger mode, Exposure control is Trigger Width

Trigger active 
edge – Rising

Trigger
width

Exposure time =
Trigger width

 
The minimum trigger period is equal to the maximum exposure time plus the camera readout 
time: 

Trigger Period (min) = Exposure Time (max) + Readout Time, 

where the Readout Time is equal to the CurrentFrameTime (in free-running mode, with 
AcquisitionFrameRateEnable disabled). 

If the next trigger pulse appears during the previous trigger period, the camera ignores it. 
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Fast Trigger Mode 
In Fast Trigger mode, the exposure and readout are overlapped in a way that is similar to free-
running (untriggered mode). Fast trigger mode depends upon a constant and stable trigger 
source so the camera can position the exposure period to conclude just as the previous frame 
readout ends. If the trigger period varies, the exposure varies with the trigger period, and 
uneven image illumination or wavering image brightness results. 

An external timing pulse controls the start of the exposure when exposure control mode is 
Timed. The new exposure ends just as the readout of the current frame ends. The readout of the 
next frame begins with the next trigger. If the next trigger pulse appears during the previous 
trigger period, the camera ignores it. 

Trigger

Exposure time Exposure N Exposure N+1

N N+1

Readout N-1 Readout NReadout time

Ignored

GenICam controls
Trigger Mode: On
Trigger Overlap: On
Trigger Source: Line 1 (or Line2, Pulse Generator)
Trigger Activation: Rising Edge (or Falling Edge)
TriggerFilterTime, TriggerDelay, TriggerDebounceTime: – set if applicable
Exposure Mode: Timed
For manual exposure control:
Exposure Time: User-specified (Min.= 36 µs; Max = Readout time)
ExposureAuto: Off
For Automatic exposure control:
ExposureAuto: Continuous (or Once)

Parameters of the external trigger pulse: 
Trigger width: ≥ 10 µs
Trigger period (min) = Readout time

Fast trigger mode, Exposure control is Timed

Trigger period ≥ Readout time

Start of 
Exposure

Trigger active 
edge – Rising

Trigger
width

Ignored

Exposure time
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You can adjust the exposure duration to be equal to the external pulse width by setting the 
exposure control mode to Trigger Width. The new exposure begins with the next trigger pulse 
during the readout of the current frame. 

Trigger

Exposure time Exposure N Exposure N+1

N N+1

Readout N Readout N+1Readout time

GenICam controls
TriggerMode: On
TriggerOverlap: On
TriggerSource: Line 1 (or Line2, Pulse Generator)
TriggerActivation: Rising Edge (or Falling Edge)
TriggerFilterTime, TriggerDelay, TriggerDebounceTime: set if applicable
ExposureMode: Trigger Width

Parameters of the external trigger pulse 
Trigger width: ≥ 10 µs
Trigger period: ≥ Readout time

Fast trigger mode, Exposure control is Trigger Width

Trigger active 
edge – Rising

Trigger width

Trigger period

 

Trigger Sources 
The camera allows for four sources for triggering: external Line1 or Line2, internal (pulse 
generator), and software. The minimum trigger pulse is 10 microseconds. 
 
• Line 1 – hardware Input Line GP Input1 (Trigger 1) is used as external source for the trigger 

signal. 
 

• Line 2 – hardware Input Line GP Input2 (Trigger 2) is used as external source for the trigger 
signal. 

 
• Pulse Generator – trigger source is generated by camera's internal Pulse Generator. 
 
• Software – the camera expects a computer to send a command to the camera for 

generating one short trigger pulse. You can trigger the camera by clicking the GUI Software 
Trigger button or by sending the GenICam Trigger Software command. 
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Configuring the Trigger 
To configure the camera to work in trigger mode, follow the steps below: 
 
1. Turn off the camera image acquisition. 
 
2. In the Acquisition Control menu, set TriggerMode to On. 
 
3. Set TriggerOverlap to either Readout for the camera to work in Fast Trigger mode or to Off 

for the camera to work in Standard Trigger mode. 
 
4. Select TriggerSource: 

• If TriggerSource is either Line1 (Input1) or Line2 (Input2), configure the external trigger 
signal source using LineInverter feature. 
 

• If TriggerSource is PulseGenerator, configure the camera’s internal pulse generator (see 
section Pulse Generator) and make sure that the PulseGenEnable setting is checked. 
 

• If TriggerSource is Software, you do not need to configure a signal source.  
The camera generates one short trigger pulse when you click the GUI Software Trigger button or 
send the GenICam™ Trigger Software command. 

 
5. For TriggerActivation setting, select what edge (Rising or Falling) will be used for triggering. 

 
If the TriggerActivation is RisingEdge and ExposureMode is set to 
TriggerWidth, the exposure duration will be the time the trigger 
stays high.  

 
If TriggerActivation is FallingEdge and the ExposureMode is set to 
TriggerWidth, the exposure time will last as long as the trigger 
stays low. 
 
Set TriggerActivation to FallingEdge if the camera works in Fast 
trigger mode (TriggerOverlap is set to Readout) with a trigger 
pulse width changing over time (ExposureMode is set to 
TriggerWidth). 
 

 
 

6. If applicable, set TriggerFilterTime, TriggerDebounceTime, TriggerDelay to desired values. 
The TriggerFilterTime and TriggerDebounce features are used to prevent false triggering 
when a trigger signal is being generated by an external source mapped to the camera’s Input 
1 or Input 2. 
 

TriggerFilterTime Defines the input trigger signals minimum pulse width. By setting the 
TriggerFilterTime to a value slightly less than the input signal’s pulse 
width, the camera will reject any noise with pulse widths less than the 
TriggerFilterTime setting. 
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TriggerDebounceTime Defines the time period following a triggering event in which no 
additional triggers will be accepted by the camera. Always set the 
TriggerDebounceTime to a value higher than the trigger signal’s pulse 
width. The camera filters out interfering signals once the trigger pulse 
ends. The camera ignores any pulses during the TriggerDebounceTime 
after receiving the trigger signal. 

TriggerDelay Defines the time between the beginning of the trigger pulse and the 
beginning of the exposure. The camera captures an image with some 
delay after the trigger event. 

 

Trigger

Trigger pulse width: ≥ 10 µs
TriggerFilterTime: Recommended value ≤ 75% of the Trigger pulse width
Max.TriggerFilterTime = 65535 µs
Max. TriggerDebounceTime = 65535 µs
Max. TriggerDelay = 16000000 µs 

Trigger
pulse width

Trigger period

Exposure time

Trigger
Delay

Exposure start

Ignored

Trigger
Debounce

TriggerDebounceTime

Ignored

Trigger Filter

TriggerFilterTime
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Video Amplifier Gain and Offset 

Image Sensor’s Analog and Digital Gain 
The image sensor allows you to apply up to 48 dB of gain to the image prior to A/D conversion. 
The first 24 dB of gain is analog gain and some improvement in noise performance may result. 
The camera applies the last 24 dB of gain digitally, which affects both signal and noise equally. 
 

0 dB 24 dB 48 dB
(1x) (16x) (251x)

Digital GainAnalog gain

 
 

Digital Gain 
Digital gain can be varied from 1x (0 dB) to 4x (12 dB) with a precision of ~0.00097x using the raw 
(fine) gain control. There are 3,092 gain steps from 1x gain to 4x gain. Each step increases the 
gain by 0.001. Digital Gain does not provide any improved contrast and should be used 
cautiously. 

Black Level Auto-calibration and Offset 
The camera automatically adjusts black level based on measurements of the dark reference lines 
at the start of each frame. Imperx recommends leaving the BlackLevelAuto engaged 
(Continuous). If SensorBlackLevelRecomended disabled (set to false), you can set the BlackLevel 
manually and adjust it from 0 to 4095 counts. Black level will vary with temperature and gain. 
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Data Output Format 
The image sensor digitization is set automatically based on the Pixel Format setting. A Pixel 
Format of 8- or 10-bits enables 10-bits sensor digitization while Pixel Format of 12-bits sets 
sensor digitization to 12-bits. 

With 8-bit output, the camera uses the standard bit reduction process and truncates the least 
significant bits as described below. 
 

12-bits sensor digitization 

If the camera is set to output 12-bit data, sensor data bits map directly to D0 (LSB) to D11 (MSB). 

MSB Camera Output – 12 bits LSB 
D11 D10 D9 D8 D7 D6 D5 D4 D3 D2 D1 D0 
P11 P10 P9 P8 P7 P6 P5 P4 P3 P2 P1 P0 

 
10-bits sensor digitization 

If the camera is set to output 10-bit data, sensor data bits map directly to D0 (LSB) to D9 (MSB). 
 

MSB Camera Output – 10 bits LSB 
D9 D8 D7 D6 D5 D4 D3 D2 D1 D0 
P9 P8 P7 P6 P5 P4 P3 P2 P1 P0 

If the camera is set to output 8-bit data, sensor most significant data bits (P2 to P9) map to D0 
(LSB) to D7 (MSB). 

MSB Camera Output – 8 bits LSB   
D7 D6 D5 D4 D3 D2 D1 D0 - - 
P9 P8 P7 P6 P5 P4 P3 P2 P1 P0 
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Pulse Generator Settings 
The camera has a built-in pulse generator that you can program to generate a discrete sequence 
of pulses or a continuous sequence. You can use the pulse generator as a trigger signal or map it 
to one of the outputs. You can set the discrete number of pulses from 1 to 65535 with a step of 1 
or configure the pulse generator to work in continuous mode. 

You can also set the following options: 
 
• Granularity – Indicates the number of clock cycles used for each increment of the width 

and the period. Four possible options are available: x1, x10, x100, and  
x 1000. 
 

• Width – Specifies the amount of time (determined by the granularity) the pulse remains at 
a high level before falling to a low level. 

 
• Period – Indicates the amount of time (also determined by the granularity) between 

consecutive pulses. 

 

Period

Width
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Input / Output Control 
The camera supports two inputs and two outputs (TTL and opto-isolated): 

Input / Output # Pin # Description Voltage/Current 

Input 1 Pin 8 and Pin10 (Return) Opto-isolated Voltage 3.3–24 V,  
Current (min) 3.3 mA 

Input 2 Pin 9 and Pin 11 (Return) TTL/LVTTL Voltage 5 V (TTL) or 3.3 V (LVTTL) 
Current (max) 2.0 mA 

Output 1 Pin 7 and Pin 6 (Return) TTL Voltage 5.0 V (TTL) 
Current (max) 8.0 mA 

Output 2 Pin 12 and Pin 5 (Return) Opto-isolated Voltage (max) 25 V 
Current (max) 50 mA 

You can map Input 1 or Input 2 to the camera trigger source by following the steps 1 – 6 in the 
section Configuring the Trigger. In Step 4, set TriggerSource to Line 1 (Input1) or Line 2 (Input2) 
respectively. 
 
You can invert the input signal by using LineInverter setting in the Digital IO Control menu: 

1. Select Input1 or Input2 in LineSelector. 
 

2. Check the LineInverter box. 
 
You can map one of nine signals to either Output 1 or Output 2 in the Digital IO Control menu: 

1. Set LineSelector to Output1 or Output2. 
 

2. Select output signal in LineSource menu (refer to the section Strobe and Synchronization 
Controls). 

 
3. You can invert the output signal by checking the LineInverter box.  

 
4. If applicable, enable a strobe and specify its width, delay, and reference (for more 

information, refer to the section Configuring the Strobe in Free-Running Mode or 
Configuring a Strobe in Trigger Mode). 
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Strobe and Synchronization Controls 
The camera allows you to synchronize your system from several references. You can synchronize 
with the trigger input, the start, middle or end of exposure, or the internal pulse generator 
signals. 

Output Signal Description 

ExposureStart A 10-microsecond pulse indicating the beginning of the exposure 

ExposureEnd A 10-microsecond pulse indicating the end of the exposure 

MidExposure A 10-microsecond indicating the middle of the exposure 

ExposureActive The output signal is active for the duration of exposure time 

TriggerActual Maps the input trigger pulse to the output with no delay 

TriggerDelayed Maps the input trigger pulse to the output with trigger delay 

PulseGenerator Maps the internal pulse generator waveform to the output 

Strobe1 Maps the Strobe 1 signal to the corresponding external output 

Strobe2 Maps the Strobe 2 signal to the corresponding external output 

 
The camera provides signals indicating the start of exposure, mid-exposure, and end of exposure. 
These signals have a fixed duration of 10 microseconds. If a longer pulse period is required, the 
strobe feature can be used. 
 
The camera provides two strobes for synchronization with an external light source, other 
cameras, or peripheral devices. You can position each strobe pulse within the entire frame-
timing period with a precision of 1.0 microsecond. 
 
You can position a strobe pulse with the following references, depending on the camera mode: 
 
Camera Mode Strobe Reference 

Free-running mode Start of Exposure, Start of Readout 

Trigger mode 
(Standard and Fast) 

Start of Exposure, Start of Readout, Trigger 

 
  



Cheetah Pregius Camera with 10 GigE Vision Interface – User Manual  

 May 6, 2021 Page 140 of 181  Rev 1.1 

Configuring the Strobe in Free-Running Mode 
In free-running mode, you can set the strobe pulse duration (StrobeWidth) and the delay 
(StrobeDelay) with respect to the start of the exposure or the start of the readout period. The 
strobe period is equal to the frame time. You can map a strobe to either Output 1 (TTL) or 
Output 2 (opto-isolated). 

Positioning the Strobe1 with a Reference to the Exposure Start 
1. In the DigitalIOControl menu, set LineSelector to Output1 (TTL) or Output2 (opto-isolated). 
 
2. Set LineSource to Strobe1. 

The strobe is mapped to the output selected under LineSelector. 
 

3. If necessary, check the LineInverter box. 
It inverts the output signal. 
 

4. Set Strobe1Reference to Start of Exposure.  
 
5. Set Strobe1Enable to On. 

 
6. If necessary, set Strobe1Delay. 

Without a delay, the strobe occurs simultaneously with the start of exposure. 
 
7. Set Strobe1Width to a desired value. 
 

Positioning the Strobe2 with a Reference to the Readout Start 
1. In the DigitalIOControl menu, set LineSelector to Output1 (TTL) or Output2 (opto-isolated). 
 
2. Set LineSource to Strobe2. 

The strobe is mapped to the output selected under LineSelector. 
 

3. If necessary, check the LineInverter box. 
It inverts the output signal. 
 

4. Set Strobe2Reference to Start of Readout.  
 
5. Set Strobe2Enable to On. 

 
6. If necessary, set Strobe2Delay. 

Without a delay, the strobe occurs simultaneously with the start of exposure. 
 
7. Set Strobe2Width to a desired value. 
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Exposure time Exposure N Exposure N+1

Readout N-1 Readout NReadout time

Strobe 1
(Strobe1Reference: 
Exposure)

Strobe 2
(Strobe2Reference: 
Readout)

Strobe 1 
delay

Strobe 2 
delay

Exposure N+2

Readout N+1

Strobe 1 
width

Strobe 2 
width

Strobe 1 period

Strobe 2 period

GenICam controls
TriggerMode: Off

LineSelector: Output1 (or Output2)
LineSource: Strobe1 (or Strobe2)
Strobe1Reference: Exposure
Strobe1Enable: On
Strobe1Width: User-specified (in µs)
Strobe1Delay: User-specified (Min.= 10 µs)
Strobe2Reference: Readout
Strobe2Enable: On
Strobe2Width: User-specified (in µs)
Strobe2Delay: User-specified (Min.= 10 µs)

Exposure Mode: Timed (or Off)
For manual exposure control:
Exposure Time: User-specified (Min.= 36 µs; Max = Readout time)
ExposureAuto: Off
For automatic exposure control (AEC):
ExposureAuto: Continuous (or Once)

Parameters of the strobe signal 
Strobe period = frame time

Strobes Positioned with Respect to the Start of Exposure and Readout, 
Free-running Mode
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Configuring a Strobe in Trigger Mode 
If the camera is in the Trigger mode (Standard or Fast Trigger), you can set the strobe pulse 
duration and the delay with respect to the trigger pulse active edge, start of the exposure, or 
start of the readout period. The strobe period equals the trigger period. 

Positioning the Strobe1 with a Reference to Trigger or Exposure Start 
1. Make sure that TriggerMode is On in the Acquisition Control menu. 

 
2. Select a TriggerSource and TriggerActivation. 
 
3. Set TriggerDelay to 0. If applicable, set TriggerFilterTime and TriggerDebounce to desired 

values. 
 

4. In the DigitalIOControl menu, set LineSelector to Output1 (TTL) or Output2 (opto-isolated). 
 
5. Set LineSource to Strobe1. 

The strobe is mapped to the output selected under LineSelector. 
 

6. If necessary, check the LineInverter box. 
It inverts the output signal. 
 

7. Set Strobe1Reference to Trigger (or Start of Exposure).  
 
8. Set Strobe1Enable to On. 

 
9. If necessary, set Strobe1Delay. 

Without a delay, the strobe occurs simultaneously with the trigger active edge (start of exposure). 
 
10. Set Strobe1Width to a desired value. 

Positioning the Strobe2 with a Reference to the Readout Start 
1. Make sure that TriggerMode is On in the Acquisition Control menu.  

 
2. Select a TriggerSource and TriggerActivation. 
 
3. If applicable, set TriggerDelay, TriggerFilterTime and TriggerDebounce to desired values. 
 
4. In the DigitalIOControl menu, set LineSelector to Output1 (TTL) or Output2 (opto-isolated). 
 
5. Set LineSource to Strobe2. 

The strobe is mapped to the output selected under LineSelector. 
 

6. If necessary, check the LineInverter box. 
It inverts the output signal. 
 

7. Set Strobe2Reference to Start of Readout.  
 
8. Set Strobe2Enable to On. 
 

 



Cheetah Pregius Camera with 10 GigE Vision Interface – User Manual  

 May 6, 2021 Page 143 of 181  Rev 1.1 

 
9. If necessary, set Strobe2Delay. 

Without a delay, the strobe occurs simultaneously with the start of exposure. 
 
10. Set Strobe2Width to a desired value. 

Trigger

Exposure time Exposure N Exposure N+1

N N+1

Readout N Readout N+1Readout time

Strobe 1
(Strobe1Reference: 
Trigger or Exposure)

Strobe 2
(Strobe2Reference: 
Readout)

Strobe 1 
delay

Strobe 2 
delay

Strobe 1 period = Trigger period

Strobe 1 
width

Strobe 2 
width

Strobe 2 period = Trigger period

Trigger active 
edge – Rising

GenICam controls
TriggerMode: On
TriggerOverlap: Off
TriggerSource: Line 1 (or Line2, Pulse Generator)
TriggerActivation: Rising Edge (or Falling Edge)
TriggerDelay: 0 (no delay)
TriggerFilterTime, TriggerDebounceTime: set if applicable

LineSelector: Output1 (or Output2)
LineSource: Strobe1 (or Strobe2)
Strobe1Reference: Trigger (or Exposure)
Strobe1Enable: On
Strobe1Width: User-specified (in µs)
Strobe1Delay: User-specified (Min.= 10 µs)
Strobe2Reference: Readout
Strobe2Enable: On
Strobe2Width: User-specified (in µs)
Strobe2Delay: User-specified (Min.= 10 µs)

Exposure Mode: Timed
For manual exposure control:
Exposure Time: User-specified (Min.= 36 µs; Max = Readout time)
ExposureAuto: Off
For automatic exposure control (AEC):
ExposureAuto: Continuous (or Once)

Parameters of the strobe signal 
Strobe period = Trigger period

Strobes Positioned with Respect to a Trigger, Exposure Start, or Readout Start
Standard Trigger Mode
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Strobe 1 is positioned with respect to the exposure start with a trigger delay. The camera is in 
Standard Trigger mode with Timed Exposure Control. 
 

Trigger

Exposure time
Exposure N Exposure N+1

N N+1

Readout N Readout N+1
Readout time

Strobe 1
(Strobe1Reference: 
Exposure)

Strobe 1 
delay

Strobe period = Trigger period

Strobe 1 
width

Trigger delay

Trigger active 
edge – Rising

GenICam controls
TriggerMode: On
TriggerOverlap: Off
TriggerSource: Line 1 (or Line2, Pulse Generator)
TriggerActivation: Rising Edge (or Falling Edge)
TriggerDelay: User-specified (Min.= 10 µs)
TriggerFilterTime, TriggerDebounceTime: set if applicable

LineSelector: Output1 (or Output2)
LineSource: Strobe1 (or Strobe2)
Strobe1Reference: Exposure
Strobe1Enable: On
Strobe1Width: User-specified (in µs)
Strobe1Delay: User-specified (in µs)

Exposure Mode: Timed
For manual exposure control:
Exposure Time: User-specified (Min.= 36 µs; Max = Readout time)
ExposureAuto: Off
For automatic exposure control (AEC):
ExposureAuto: Continuous (or Once)

Parameters of the strobe signal 
Strobe period = Trigger period

Strobes Positioned with Respect to the Exposure Start
Standard Trigger Mode
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If your application requires activating a light source before the start of the exposure period, you 
can use StrobeReference and StrobeDelay settings to position the strobe to occur earlier that the 
exposure. To configure the strobe, follow the steps below: 
1. Make sure that TriggerMode is On and TriggerDelay is set to a desired value in the 

Acquisition Control menu.  
The Exposure starts with the delay after the trigger event. 
 

2. Set StrobeReference to Trigger. The strobe occurs simultaneously with the trigger active 
edge. 
 

3. Set StrobeDelay to a value lower than the TriggerDelay duration. 
 
4. Set StrobeWidth to a desired value. 

Trigger

Exposure time Exposure N Exposure N+1

N N+1

Readout N Readout N+1Readout time

Strobe 2
(Strobe2Reference: 
Trigger) Strobe 2 

delay

Strobe 2 period = Trigger period

Strobe 2 
width

Trigger delay

Strobe 1
(Strobe1Reference: 
Trigger)

Strobe 1 period = Trigger period

Strobe 1 
width

Trigger active 
edge – Rising

GenICam controls
TriggerMode: On
TriggerOverlap: Off
TriggerSource: Line 1 (or Line2, Pulse Generator)
TriggerActivation: Rising Edge (or Falling Edge)
TriggerDelay: User-specified (Min.= 10 µs)
TriggerFilterTime, TriggerDebounceTime: set if applicable

LineSelector: Output1 (or Output2)
LineSource: Strobe1 (or Strobe2)
Strobe1Reference: Trigger
Strobe1Enable: On
Strobe1Width: User-specified (in µs)
Strobe1Delay: 0 (no delay)
Strobe2Reference: Trigger
Strobe2Enable: On
Strobe2Width: User-specified (in µs)
Strobe2Delay: User-specified (in µs)

Exposure Mode: Timed
For manual exposure control:
Exposure Time: User-specified (Min.= 36 µs; Max = Readout time)
ExposureAuto: Off
For automatic exposure control (AEC):
ExposureAuto: Continuous (or Once)

Parameters of the strobe signal 
Strobe period = Trigger period

Strobes Positioned with Respect to the Trigger
Standard Trigger Mode
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Area of Interest 
For some applications, you might not need the entire image, but only a portion of it. To 
accommodate this requirement, the Cheetah camera allows you to create one Region of Interest 
(ROI), also known as an Area of Interest (AOI). 

Horizontal and Vertical Window 
Set the starting and ending point for each AOI independently in the horizontal direction 
(Horizontal Window) and the vertical direction (Vertical Window) by setting the window (H & V) 
offset and (H & V) size. The horizontal dimension is limited to multiples of 32 pixels, and the 
vertical dimension is limited to multiples of 4 pixels. In normal operation, the AOI defines the 
number of columns and rows output. The maximum horizontal window size (H) and the vertical 
window size (V) are determined by the camera’s image full resolution. 

 
 

For color cameras with AOI enabled, use an even number for Offset X and 
Offset Y to achieve proper color reconstruction and white balance. 

 

Factors Impacting Frame Rate 
The camera frame rate depends upon a number of variables including the exposure time, 
number of rows and columns in the AOI, and the bandwidth of the output interface. 

AOI size: Camera frame rate increases by decreasing either the number of columns or number of 
rows read out. Changing the number of rows read out causes the largest change in frame rate.  

Exposure Time: In free-running or Fast trigger mode, the camera overlaps the exposure time and 
image readout so frame rate has no dependence on exposure time. In Standard trigger mode, 
however, the exposure and readout time do not overlap, and long exposure times will decrease 
frame rate. 

Line time: This is the time required to read out one line from CMOS sensor. Increasing the line 
time decreases the camera frame rate and extends exposure time. Please note that the extended 
line time decreases bandwidth usage.  

Decimation: The camera supports both binning and sub-sampling decimation to reduce the 
output resolution. Binning and sub-sampling increase the sensor frame rate. However, sub-
sampling offers the largest frame rate improvement by reducing the number of rows and 
columns read out from the image sensor. Binning and sub-sampling provide about a 2x to 3x 
increase in frame rate. 
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Binning and Subsampling Decimation 

Binning 
The principal objective of the binning function is to reduce the image resolution with better final 
image quality than a subsampling function. Binning reduces the output resolution by summing 
several pixels together and has the advantage of reducing aliasing, increasing signal-to-noise 
ratio (SNR). Subsampling – as opposed to binning – has the advantage of increasing the output 
frame rate by reducing the number of rows read out, but also can introduce aliasing in the final 
image. Subsampling, however, increases the output frame rate more than binning. 

The following graphic illustrates the concept of 4:1 binning for a monochrome image sensor. The 
values of pixels P1, P2, P3 and P4 are summed together resulting in a single larger pixel output 
value.  
The binning feature can be used on the full resolution image or within any area of interest. 
 

 
 
 
 

You cannot apply both binning and subsampling decimation simultaneously. 
 
Color cameras do not support binning. 
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Subsampling Decimation 
Subsampling reduces the number of pixels output by reducing the output frame size but 
maintains the full field of view. If an area of interest (AOI) is selected, then the field of view of 
the AOI is maintained. 

The cameras employ a “keep one pixel, skip one pixel” sequence. When enabled in both x and y, 
every other pixel within a line is retained, and every other line within the image is retained. 

Monochrome subsampling: 

 

Color subsampling: 
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Lookup Tables 
The user-defined LUT (Lookup Table) feature transforms any 12-bit video data into any other 12-
bit value. For the 10-bit sensor digitization, the camera multiplies the 10-bit pixel data by 4 to get 
12-bit pixel data for input into the 12-bit LUT. After the 12-bit LUT transforms the data, the 
camera divides the 12-bit data by 4 to get 10-bit pixel values for output to the camera interface.  
 

 
 
The camera supports a Gamma control feature and four separate LUTs. All LUTs are available for 
modifications. You can generate and upload a custom LUT using the Imperx Upload Utility (see 
Uploading the LUT File). 
 
You can control the image luminance by setting the Gamma control or/and by enabling one of 
the LUT. When both Gamma and LUT enabled, the camera implements the Gamma control first 
and then applies the LUT. 

Factory LUTs 
Each LUT consists of 4096 entries, with each entry being 12 bits wide. LUT1 and LUT3 are factory 
programmed with a standard Gamma 0.45, LUT2 and LUT4 are pre-programmed with negative 
LUT (LUTOUTPUT = 4095 – LUTINPUT). 

The Gamma 0.45 LUT uses the following formula: 

LUT OUTPUT (ADU with 12 bpp) = 4095 * [(LUTINPUT/4095) 0.45] 

For example, if the LUTINPUT is 1024 ADU (12 bpp), then LUTOUTPUT is 
4095*(1024/4095)^0.45=2195. 
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User Defined LUT 
You can define any 12-bit to 12-bit transformation as a user LUT and upload it to the camera using 
Imperx Upload Utility (see Uploading the LUT File). You can specify a transfer function to match 
the camera’s dynamic range to the scene’s dynamic range. There are no limitations to the profile 
of the function. The LUT must include all possible input values (0 to 4095) (refer to the Appendix 
C: Look Up Tables). 
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Hot and Defective Pixel Correction 
A CMOS imager is composed of a two-dimensional array of light sensitive pixels. In general, most 
of the pixels have similar sensitivity. However, some pixels deviate from the average pixel 
sensitivity and are called defective pixels and hot pixels. 

Defective pixels (also known as dead pixels)—these are pixels whose sensitivity deviates due to 
fluctuations in the CMOS manufacturing process and materials. Two types of defective pixels are 
possible: 

• Dark – a pixel whose sensitivity is lower than the sensitivity of the adjacent pixels. In some 
cases, this pixel will have no response (completely dark). 

• Bright – a pixel whose sensitivity is higher than the sensitivity of the adjacent pixels. In some 
cases, this pixel will have full response (completely bright). 

Hot pixels – these are pixels that in normal camera operation behave as normal pixels (sensitivity 
equal to one of the adjacent pixels). But during long exposures or at elevated temperatures, the 
pixel becomes far brighter than the average of the pixels surrounding it. In some cases, the pixel 
becomes so bright that it saturates.  

At the factory, final testing identifies and stores maps of both hot and defective pixels. Enabling 
DefectPixelCorrection and BadPixelCorrection using the Factory option, corrects hot and 
defective pixels using the Factory map.  

The camera employs static pixel maps to correct up hot and defective pixels. During factory 
testing, engineers identify the coordinates of hot and defective pixels. They create a map file 
listing the pixel coordinates of these pixels by row and column, and the camera corrects the hot 
and defective pixels found at these coordinates. The map file downloads into the camera's non-
volatile memory. 

When Factory or User correction is enabled, the camera compares each pixel’s coordinates with 
entries in the pixel map. If a match is found, the camera corrects the defective pixel.  

You can create your own Hot Pixel Map (HPM) or Defective Pixel Map (DPM) file and upload it 
using the Imperx Upload Utility application (refer to the Appendix B for more information). 

Flat Field Correction 
The camera uses a factory installed flat field correction (located in FFC0) algorithm to correct 
some of the image sensor’s non-uniformity. You can upload your own FFC table to one of the 
FFC1 – FFC8 tables using Imperx Upload Utility. While not recommended, you can disable the 
FFC. 
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Test Image Pattern 
The camera can output several test images to verify the camera’s general performance and 
connectivity to the computer. This ensures that all the major modules in the hardware are 
working properly and the connection between your computer and camera is synchronized, that 
is, the image framing, output mode, communication rate, and so on are properly configured. 
Note that test image patterns do not exercise and verify the image sensor functionality. The 
following table show a list of test images available. 

Test pattern Description 

Off Image is coming from the sensor 

GreyHorizontalRamp Image is filled horizontally with an image that goes from the darkest 
possible value to the brightest 

GreyVerticalRamp Image is filled vertically with an image that goes from the darkest possible 
value to the brightest 

GreyHorizontalRampMoving Image is filled horizontally with an image that goes from the darkest 
possible value to the brightest and that moves horizontally from left to 
right at each frame. 

GreyVerticalRampMoving Image is filled vertically with an image that goes from the darkest possible 
value to the brightest and that moves vertically from top to bottom at 
each frame. 

FlatField Displays a constant grey value. 

IpxGevPattern GEV engine firmware generate an image. 

Automatic White Balance 
The camera provides white balance options for controlling image color under different lighting 
conditions. You can load the camera with your preferred white balance coefficients or let the 
camera determine the color coefficients one time or continuously (auto). 

AWB Mode Description 

Off AWB is disabled and a manual control is on. The camera applies the correction 
coefficients you enter using the BalanceRatioSelector and BalanceRatio controls. 

Once The camera analyzes one image frame, calculates only one set of coefficients, and 
corrects all subsequent frames with this set of coefficients.  

Continuous The camera analyzes every frame, derives a set of correction coefficients for each 
frame, and applies them to the next frame. You can set a tracking speed to be from 
1 to 64 with 1 being the slowest and 64 the fastest. 

To compensate for color shift, the Green channel is used as a reference and the Red and Blue 
channel gains are changed to match the Green channel. For example, to increase the Red 
channel gain by 75%, set the Red BalanceRatio to 1.75x. The camera applies 75% more gain to 
the Red channel than to the Green. 
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Manual Control over the Correction Coefficients (AWB mode: Off) 

To adjust the Red and Blue channel gain coefficients with respect to Green (the reference), use 
the control BalanceRatioSelector to point to the color (Red or Blue) whose gain should be 
adjusted. Then BalanceRatio control is used to set a gain value between 0.25x to 4.00x for the 
selected color. The Green channel gain is always set to 1. 

 
BalanceRatio value Red/Blue channel gain 

from 0.25x to 0.99x the channel gain decreases 

from 1.01x to 4.00x the channel gain increases 

1.00x the gain does not change 

To disable Auto-White Balance, set BalanceRatio to 1.00x for both Red and Blue channel gains. 

EXAMPLE 

To set Blue channel gain with respect to Green to 2x and set Red channel gain to 0.8x: 
 
1. On AnalogControl panel, set BalanceWhiteAuto to Off. 

 
2. Set BalanceRatioSelector to Blue. 
 
3. Set BalanceRatio to 2.00. 

 
 

4. Set BalanceRatioSelector to Red. 
 

5. Set BalanceRatio to 0.80.  

 
 

6. Save this configuration to one of the User Sets (see section Configuration Memory). 
  

2 

3 

1 

4 

5 
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AWB mode: Once 

For the best color reproduction when the source has a stable spectral output, Imperx suggests 
illuminating a uniformly grey card with the intended source then using the Once option to 
determine the coefficients and then saving these coefficients into the camera and saving this 
configuration to one of the User Sets. 
 
To get the best white balance coefficients when the spectral source is constant: 
1. Image a grey or white target over the camera’s entire field of view using the intended 

lighting source. 
 

2. Select Once mode for the BalanceWhiteAuto. The Red and Blue coefficients appear in the 
BalanceRatio area. 

 
3. Save this configuration to one of the User Sets (see section Configuration Memory). 

AWB mode: Continuous 

The camera automatically adjusts the Red and Blue channel gains when BalanceWhiteAuto is set 
to Continuous. 
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Canon Lens Control 
Make sure that a switch on your Canon EOS EF lens is set to Auto (AF), and Visibility is set to 
Guru on the IpxPlayer GUI screen: 

 
 
The camera initializes the lens upon power cycling. Check Lens Controller Status parameter. If 
the status is InitLens_Done, the initialization was successfully completed, and you can start 
adjusting the lens. If the initialization failed, issue InitLens command on Controller Setting 
screen. 

Focus Control 
1. For the camera to learn the range of the Canon lens’s Focus Encoder, issue the following 

sequence of commands: 
a. Issue the Canon Focus Near-Full command. 

 
b. Issue the Reset Focus Encoder command. 

 
c. Issue the Canon Focus Far-Full command. 

 
d. Issue the Get Focus Encoder Status command. 

 
e. Issue the Focus Set Max command. The Focus Max parameter will be adjusted 

automatically to this value.  
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2. Set FocusReqPosition to a desired value. 
 

3. Issue the SetFocusPosition command and the lens will move to the FocusReqPosition value. 
FocusEncoderStatus will be updated to reflect the new position 
 
The Focus Encoder uses   a Hall effect sensor and is not perfectly precise, so FocusEncoderStatus 
values can vary. It does not provide sufficiently accurate location information to change lens 
focus after power cycling and the error tends to increase with the  number of focus movements. 
However, once the lens is focused, it will retain focus after repeated power cycling. 
 
The FocusEncoderStatus is a signed binary value (2’s complement). Negative values can result if 
the Focus Encoder position is close to the Near Full position. For example, a value of 65352 
means negative 184 or 184 steps past the Near Full Position. 

Iris Control 
A Canon EF EOS lens provides an iris range in raw units and the camera reads out an iris range 
from a Canon lens in raw units upon issuing the GetIrisRange command. Each time the iris is 
changed, the camera calculates and returns the CurrentFNumber using the following formula: 
CurrentFNumber = Sqrt (2)^[(Raw unit/8) - 1] 
For example, if Raw unit = 32, then CurrentFNumber = 2.83. 
 
Using XML features IrisRequestedPositionRaw and SetIrisPosition, you can set an aperture to a 
required value. The aperture will be changed with IrisStepValue until it is greater than or equal to 
the target position in raw units.  
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Configuration Memory 
The camera has built-in configuration memory divided into six segments: Work Space, Factory 
Space (Default), User Space #0, #1, #2 or #3. The Work Space segment contains the current 
camera settings while the camera is powered up and operational. All camera registers are in this 
space. You can program these registers and change the camera configuration through these 
registers. 
 
The Work Space is RAM based. All camera registers clear upon camera power-down. The Factory 
Space (Default) segment is ROM based, write protected, and contains the default camera 
settings. This space is available for read operations only. User Space #0, #1, #2 and #3 are non-
volatile, flash-based, and used to store up to four user defined configurations or User Sets. Upon 
power up or software reset, the camera firmware loads the Work Space registers from the 
Factory Space (Default), User Space #0, #1, #2 or #3 as determined by a User Set Default Selector 
setting.  
 
At any time, you can instruct the camera to load its Work Space with the contents of the Factory 
Space, User Space #0, #1, #2 or #3 by first using the UserSetSelector to point to the desired User 
Set then using the UserSetLoad command.  
 
Similarly, you can instruct the camera to save the current Work Space settings into either User 
Space #0, #1, #2 or #3 by using the User Set Selector to point to the desired User Set and then 
using the User Set Save command: 

1. In the User Set Control menu, point to one of the User Sets to store your configuration using 
the UserSetSelector.  

 

2. Execute UserSetSave command to save your configuration to the camera’s non-volatile 
memory. 
 

3. Select your User Set (must be the same as in step 2) in UserSetDefault menu.  
The camera loads and activates this User Set upon the next reset or upon power-up. 

 

1 

2 

3 
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4. Power-cycle the camera for the changes to take effect. 
 
The non-volatile parameter Flash memory also contains the Bad Pixel Map (BPM), Defective Pixel 
Map (DPM), 8 Flat Field Correction (FFC) tables, and 4 LUTs which you can load to the camera’s 
internal memory upon enabling the corresponding camera feature. You can create custom LUT 
tables using the Imperx IPX Toolkit utility and upload these tables to the parameter Flash using 
the Imperx Upload Utility. Both the IPX Toolkit and IPX Upload Utility are available from the 
Imperx website https://www.imperx.com/.  

 
 
 
 

https://www.imperx.com/
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Image Sensor Technology 

General Information 
A CMOS camera is an electronic device for converting light into an electrical signal. The C4440, 
C5440, and C6440 cameras contain Sony Pregius CMOS (Complementary Metal-Oxide 
Semiconductor) image sensors with 3.45-micron square pixels. The sensors have extremely low 
dark current and no visible fixed pattern noise, which has been the bane of traditional CMOS 
image sensors.  

The Sony CMOS sensor consists of a two-dimensional array of sensitive elements called silicon 
photodiodes, also known as pixels. The photons falling on the CMOS surface create 
photoelectrons within the pixels. The number of photoelectrons is linearly proportional to the 
light level. Although the number of electrons collected in each pixel is linearly proportional to the 
light level and exposure time, the number of electrons created in the pixel during any fixed time 
period varies with the wavelength of the incident light.  

When the camera reaches the desired exposure time, it shifts the charges from each pixel 
photodiode onto a storage register within the pixel, reads out one row at a time digitizing each 
pixel at 10 or 12 bits. The user can selectively output the most significant 8, 10 or 12 bits from 
each pixel with an impact to camera’s frame rate. Frame time, or read-out time, is the time 
interval required for all the pixels to be read out of the image sensor. In non-triggered or fast 
trigger mode, while reading out the image from the storage registers within each pixel, the 
camera captures the next image. The exposure ends just as the readout of the previous frame 
ends and the next frame begins. 

The Sony CMOS image sensor digitizes each pixel within a row simultaneously. This allows for 
more settling time, which lowers the overall noise floor and provides improved sensitivity. The 
low noise floor, combined with a reasonably large pixel charge capacity and extremely low dark 
current, translates into a large dynamic range of 71 dB (12-bits) or 12 F-stops. 

The sensor allows you to apply up to 48 dB of gain to the image. The first 24 dB of gain is analog 
gain and some improvement in noise performance may result. The camera applies the last 24 dB 
of gain digitally, which affects both signal and noise equally. Additional digital gain (up to 12 dB) 
can also be applied using the Digital Gain control. 

Spectral Sensitivity 
A set of color filters (red, green, and blue) arranged in a Bayer pattern over the pixels generates 
color images. The starting color is Red for SONY Pregius image sensors and follows the pattern: 
red, green, red, green, red, … on row 1 and green, blue, green, blue, green, … on row 2 and so 
on. The color and monochrome spectral responses of the sensors used in Cheetah cameras can 
be found in Appendix A. 
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Appendix A: Spectral Response 

Cheetah C4440 Spectral Response 

 
 
 

 

Sony IMX367  
Color Spectral Response 

Sony IMX367 
Mono Spectral Response 
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Cheetah C5440 Spectral Response 

 
 
 

 

Sony IMX387  
Color Spectral Response 

Sony IMX387  
Mono Spectral Response 
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Cheetah C6440 Spectral Response 

 
 
 

 
 

Sony IMX342  
Color Spectral Response 

Sony IMX342  
Mono Spectral Response 
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Appendix B: Creating Hot and 
Defective Pixel Correction Maps 

Overview 
Hot Pixel Correction and Defective Pixel Correction work with predetermined and preloaded Hot 
and Defective pixel maps. 
 
Hot Pixel Map (HPM) and Defective Pixel Map (DPM) are uploaded into the camera’s non-volatile 
memory. 
 
You can edit the original (factory installed) HPM / DPM file and upload it into the camera to fit 
the unique requirements of your operating environment or camera use. 

Editing HPM / DPM Files 
You can edit HPM and DPM files in Microsoft Notepad or any other editing software. The file is a 
simple text file that looks like this: 
 
-- Defective Pixel Map, 
-- Date: 05.18.2020, 
-- Model#: SFP-C6440M, 
-- Serial#: LAC001, 
:Table, 
-- Column(X),Row(Y) 

5683,155 
3091,332 
3532,893 
 650,1017 
 701,1017 
1712,1053 
 914,1067 

Pixel maps have two main sections: a header and a table. The header section is a free text area 
of up to 256 ASCII characters. Each line of the header section must be terminated with a comma. 
The table section of the file contains an array of lines with each line containing an X (column 
number) value followed by a comma and a Y (row number) value. 
 
All pixels are listed in the HPM or DPM in order of increasing Y (row) location. If there are 
multiple hot or defective pixels in the same row (Y location is identical for both defective pixels), 
the listing is in order of increasing X (column) location.  

The maximum number of pixels in the DPM list is 1024 and in HPM list is 4096. 

To edit original DPM or HPM file, you need to identify defective or hot pixels, locate and adjust 
their coordinates, and accurately place pixels’ coordinates into the pixel map. 
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Finding Defective Pixels 
To see the defective pixels that are not in the factory DPM: 

1. Make sure that the DefectPixelCorrection is set to Factory in the Data Correction menu of 
the software GUI. 
The camera corrects the known pixel defects automatically. 
 

2. Make sure that TriggerMode and ExposureMode are set to Off, and the camera resolution is 
set to maximum. 
 

3. Capture an image with a uniform light source illuminating the sensor at about 50% ADU 
capacity (~2000 for 12-bit, ~500 for 10-bit, ~130 for 8-bit modes). 
 

4. Identify any visible defective pixel and add them to the  DPM as described in Locating and 
adding pixel coordinates. 
 

To see all the defective pixels, including those in the factory DPM: 

1. Set DefectPixelCorrection to Off in the Data Correction menu. 
 

2. Make sure that BadPixelCorrection is set to Factory. 
 
3. Repeat steps 2–4 of the previous procedure. 
 

To obtain the factory DPM file, contact Imperx technical support at: 
Email: support@imperx.com 
Toll Free: 1 (866) 849-1662 or (+1) 561-989-0006 
Fax: (+1) 561-989-0045 
Visit our website: www.imperx.com.  

 
To create an HPM that contains all the hot pixels, see Creating a DPM Using 
Imperx Toolkit. 
 
To upload a new DPM into the camera, see Uploading DPM / HPM Files. 

 

Finding Hot Pixels 
To see the hot pixels that are not in the factory HPM: 

1. Make sure that BadPixelCorrection is set to Factory in the Data Correction menu. 
The camera corrects the known hot pixels automatically. 
 

2. Set the longest exposure time and slowest frame rate expected. 
 

3. Put the lens cap on the camera. 
 

4. Run the camera for at least 45 minutes at ambient temperature around 18–22 °C or higher. 
 

5. Capture an image (or series of images).  
 

https://www.imperx.com/
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6. Identify all visible hot pixels and add them to the HPM as described in Locating and adding 
pixel coordinates. 

 
To see all the hot pixels, including those in the factory HPM: 

1. Set BadPixelCorrection to Off in Data Correction menu. 
 

2. Make sure that DefectPixelCorrection is set to Factory. 
 
3. Repeat steps 2–6 of the previous procedure. 
 

To obtain the factory HPM file, contact Imperx technical support at: 
Email: techsupport@imperx.com 
Toll Free: 1 (866) 849-1662 or (+1) 561-989-0006 
Fax: (+1) 561-989-0045 
Visit our website: www.imperx.com.  

 
To create an HPM that contains all the hot pixels, see Creating an HPM 
Using Imperx Toolkit. 
 
To upload a new DPM to the camera, see Uploading DPM / HPM Files. 

 
  

https://www.imperx.com/
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Locating and adding pixel coordinates 
Follow the steps below to find first pixel coordinates, locate and adjust defective pixel 
coordinates, and accurately place defective pixel coordinates into the pixel map. 
 

STEP 1: Find the First Pixel Coordinates 

Your frame grabber’s first pixel coordinates can affect the location accuracy of defective pixel 
coordinates. So, you must find the image sensor’s first pixel coordinates and potentially adjust 
the defective pixel coordinates based on your findings. 

Click the first pixel at the upper most left corner of the screen to find your frame grabber’s first 
pixel X, Y coordinates. 
 

 
 
The coordinates will be either 0, 0 or 1, 1: 
 
• If your frame grabber’s first pixel coordinates are 0, 0, you should add 1 to both the X and Y 

coordinates of the defective pixel. 
 

• If the first pixel coordinates are 1, 1, do not add 1 to either coordinate. 
  

a. Click the first pixel. 

b. This frame grabber image shows the first 
pixel coordinates as 0, 0. 

X:0 Y:0 
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STEP 2: Find Defective Pixel Coordinates 

Click the defective pixel to find its X, Y coordinates. 
 

 
 

The coordinates are 593, 4816, where X (Column) = 593 and Y (Row) = 4816.  

IMPORTANT: Frame grabbers from different manufacturers may display pixel location 
coordinates in different order, for example:  

X (Column), Y (Row) or, 
X (Row), Y (Column). 

You must put defective pixel coordinates into the pixel correction map file in this order: 
X (Column), Y (Row). 

If your frame grabber identifies pixel coordinates by X (Row), Y (Column), you must transpose 
the coordinates to X (Column), Y (Row) before entering them into the pixel map files. For 
example, if the 593, 4816 coordinates in the screen above had been displayed in this order, 
where X:593 is a row and Y:4816 is a column, you would have had to transpose the coordinates 
to 4816, 593. 
 

STEP 3: Adjust Defective Pixel Coordinates 

As described in STEP 1, if the first pixel coordinates are 0, 0, you must adjust the defective pixel 
coordinates by adding 1 to both coordinates as shown in the following: 

593 (+1), 4816 (+1) = 594, 4817 

• If the frame grabber pixel coordinates are Column (X), Row (Y), then go to STEP 4. 

• If the frame grabber pixel coordinates are Row (X), Column (Y), then transpose the 
coordinates to the form Column, Row and then go to STEP 4. 

a. Click the pixel to display X, Y 
coordinates below. 

X:593 Y:4816 
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STEP 4: Add Defective Pixel Coordinates to Defective Pixel Map 

Place the defective pixel coordinates in the Defective Pixel Map file in ascending (increasing) 
numerical order of the Y (row) coordinate. The value of all Y coordinates should progressively 
increase as you look down the list of X, Y coordinates.  

 
Example 1: Different Y coordinates  Example 2: Identical Y coordinates 

-- Defective Pixel Map, 
-- Date: 5.18.2020, 
-- Model#: SFP-C6440M-RF, 
-- Serial#: LAC001, 
:Table, 
-- Column(X),Row(Y) 
701,1017 
100,1018 
4325,1019 
2241,1020 
458,1021 
1712,1053 
914,1067 
3954,1546 
2516,1670 
3451,3331 
1111,4149 
95,4364 
594,4817 
433,4828 

 -- Defective Pixel Map, 
-- Date: 5.18.2020, 
-- Model#: SFP-C6440M-RF, 
-- Serial#: LAC001, 
:Table, 
-- Column(X),Row(Y) 
650,1017 
698,1017 
701,1017 
100,1018 
4325,1019 
2241,1020 
458,1021 
1712,1053 
f914,1067 
3954,1546 
2516,1670 
3451,3331 
1111,4149 
95,4364 
433,4828 

As shown in the Example 1 above, the Y coordinate of 594, 4817 is higher than 4364 and lower 
than 4828. Do not add defective pixel coordinates at the end of the list unless the Y coordinate is 
the highest of all Y values.  
 
 

If adding a defective pixel with a Y location identical to one or more other 
defective pixels, insert its coordinates based on the order of increasing X 
location. 

 
 

As shown in the Example 2 above, the Y coordinate of 698, 1017 is identical to two other 
defective pixels. Place its coordinates between 650, 1017 and 701, 1017 because its X location 
(698) is higher than 650 but lower than 701. 

STEP 5: Save your DPM/HPM 

• Save your Defective Pixel Map with the file extension .dpm. 
 

• Save your Hot Pixel Map with file extension .hpm. 
  

Row coordinates are 
in ascending order 
(increasing Y values). 

Column coordinates are in 
ascending order (increasing 
X values). 
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Creating a DPM/HPM Using a Text Editor 
You can create your own DPM and HPM files using any ASCII text editor, such as Notepad or 
similar. Alternatively, any spreadsheet program (i.e. Microsoft Excel) can be used by converting 
the spreadsheet into a comma delimited (.csv) file. In either case, the file must be renamed to 
include the .dpm or .hpm file extension. The files look like this: 

-- Defective Pixel Map, 
-- Date: 5.18.2020, 
-- Model#: SFP-C6440M, 
-- Serial#: LAC001, 
:Table, 
-- Column(X),Row(Y) 

5683,155 
3091,332 
3532,893 
 650,1017 
 701,1017 
1712,1053 
 914,1067 

Pixel maps have two main sections: a header and a table. The header section is a free text area 
of up to 256 ASCII characters. Each line of the header section must be terminated with a comma. 
The table section of the file contains an array of lines with each line containing an X (column 
number) value followed by a comma and a Y (row number) value. 

All pixels are listed in the DPM or HPM in order of increasing Y (row) location. If the Y location is 
identical, the listing is in order of increasing X (column) location.  

The maximum number of pixels in the DMP list is 1024 and in HPM list is 4096. 

To create a DPM or HPM file: 
1. Identify defective or hot pixels (refer to the sections Finding Defective Pixels and  Finding 

Hot Pixels).  

IMPORTANT: When creating a new pixel map, you need to get all defective pixel visible. 
Make sure that the DefectivePixelCorrection and BadPixelCorrection are set to Off in the 
Data Correction menu of the software GUI, so the camera does not correct the known pixel 
defects. 
 

2. Locate and adjust defective pixels’ coordinates (refer to the section Locating and adding 
pixel coordinates, STEP1 – STEP3). 
 

3. Place pixels’ coordinates into the pixel map and save the file (refer to the section Locating 
and adding pixel coordinates STEP4, STEP5). 

EXAMPLE 
In this example, the first table entry is pixel 4 from row 1, the next entry is pixel 588 from row 1, 
and the next entry is pixel 78 from row 5, and so on. The file looks like this: 

:Table, 
-- Column(X),Row(Y) 

   4,1 
 588,1 
  78,5 
  82,27 
 405,300 
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Creating a DPM Using Imperx Toolkit 
1. Set DefectPixelCorrection to Off in the Data Correction menu. 

 
2. Make sure that BadPixelCorrection is set to Factory. 
 
3. Make sure that TriggerMode and ExposureMode are set to Off, and the camera resolution is 

set to maximum. 
 

4. Capture an image (or series of images) with a uniform light source illuminating the sensor at 
about 50% ADU capacity (~2000 for 12-bit, ~500 for 10-bit, ~130 for 8-bit modes) and Save 
the image(s) in RAW format. 

 
5. In the IpxToolkit main window, navigate to the saved RAW file(s) and open it. 
 
6. On the Image Properties tab: 

• Set Setup Mode to Manual. 

• Set Device Type GigE Vision. 

• Set Width and Height to the RAW image’s vertical and horizontal size respectively. 

• Set Pixel Type to the Pixel Format of the RAW image. 
The options are Mono8, Mono10, or Mono12 for a monochrome camera and RGB8, RGB10, or 
RGB12 for a color camera. 

• Click Apply. 
 

7. Select Tools > DPM/HPM Utility. 
 
8. On the Dark & Bright tab, navigate to the saved RAW file(s) and open it. 
 
9. Move the Dark slider to the value that you want to be the maximum luminosity for the dark 

pixels. 
The pixels are treated as dark if their luminosity is lower than the Dark limit. 

 
10. Move the Bright slider to the value that you want to be the minimum luminosity for the 

bright pixels. 
The pixels are treated as bright if their luminosity is higher than the Bright limit. 

 
11. Click Start. 

The dark and bright pixels are added to the List of Defected Pixels table. 
The maximum number of pixels in the DMP is 1024. 
 

12. Fill out the Camera and Serial# fields and click Save to File. 
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Creating an HPM Using Imperx Toolkit 
1. Set BadPixelCorrection to Off in the Data Correction menu. 

 
2. Make sure that DefectivePixelCorrection is set to Factory. 
 
3. Set the longest exposure time and slowest frame rate expected. 

 
4. Cover a lens with a lens cap or dismount the lens and put on a dust cap on the. 
 
5. Run the camera for at least 45 minutes at ambient temperature around 18–22 °C or higher. 
 
6. Capture an image (or series of images) and save it in RAW format. 
 
7. In the IpxToolkit main window, navigate to the saved RAW file(s) and open it. 
 
8. On the Image Properties tab: 

• Set Setup Mode to Manual. 

• Set Device Type to GigE Vision. 

• Set Width and Height to the RAW image’s vertical and horizontal size respectively. 

• Set Pixel Type to the Pixel Format of the RAW image. 
The options are Mono8, Mono10, or Mono12 for a monochrome camera and RGB8, RGB10, or 
RGB12 for a color camera. 

• Click Apply. 
 

9. Select Tools > DPM/HPM Utility. 
 
10. On the Hot tab, navigate to the saved RAW file(s) and open it. 
 
11. Move the Threshold slider to the value that you want to be the minimum luminosity for the 

hot pixels. 
The pixels are treated as hot if their luminosity is higher than the Threshold limit. 

 
12. Click Start. 

The dark and bright pixels are added to the List of Defected Pixels table. 
The maximum number of pixels in HPM is 4096. 
 

13. Fill out the Camera and Serial# fields and click Save to File. 
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Uploading DPM / HPM Files 
After saving the maps, you can upload them to the camera using the Imperx Upload Utility. The 
Upload Utility enables uploads of DPM, HPM, and other files to your camera.  

To upload DPM and HPM files: 
1. Connect and power up your camera. 
 
2. Start the Imperx Upload Utility and wait for the Utility to detect the camera.  

If the utility does not detect the camera, click Refresh to restart the device collection. 
 

 
 

3. Select the camera to update if more than one appears. 
 

 
  

SFP-C6440M-RF000000  1180000 

SFP-C6440M-RF000000  1180000 
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4. Browse for either the edited .dpm file or .hpm file, select it, and click Upload.  
Wait for the upload to finish. 

 
 
5. After the upload is completed, do a power cycle on the camera. 
 
6. After the camera re-starts, start your software GUI and select Data Correction. 
 
7. Make sure that DefectivePixelCorrection and BadPixelCorrection are set to User so that the 

camera uses the maps you loaded. 
 
8. Retake images as described in sections Finding Defective Pixels and Finding Hot Pixels to 

make sure that all defective and hot pixels are now corrected. 
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Appendix C: Look Up Tables 

Creating an LUT Using a Text Editor 
You can use any ASCII text editor, such as Notepad or similar, to create a custom LUT. Alternatively, 
any spreadsheet program (i.e. Microsoft Excel) can be used by converting the spreadsheet into a 
comma delimited (.csv) file. In either case, rename the file to include the .lut file extension.  

The .lut file has two main sections: a header and a table. The header section is a free text area of 
up to 256 ASCII characters. Each line of the header section must be terminated in a comma. The 
table section of the file contains an array of 4096 lines with each line containing an input value 
followed by a comma and an output value. The input values represent incoming pixels and the 
output values represent what each incoming pixel should be converted into as an output pixel. 

The format of the .lut file is as follows: 
 
-- Look Up Table input file example, 
-- lines beginning with two dashes are comments, 
-- and are ignored by parser, 
:Header, 
-- this is the text that will get displayed with a 'glh' command, 
Function is 'Negative Image', 
Created by John Doe, 
Date 1/14/20, 
:Table, 
-- input output, 

0,4095 
1,4094 
2,4093 
3,4092 
4,4091 
: 

4095,0 
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Creating an LUT Using Microsoft Excel 
The LUT file can be created in Excel as follows: 

1. Create the spreadsheet as shown below (note that 4096 rows are required in the table). 
 

2. Add the necessary equations into the output cells to generate the transfer function required. 
 
3. Save the file as a .csv (comma delimited format). 
 
4. Rename the .csv file to an extension of .lut. 
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Creating an LUT Using Imperx Toolkit 
1. On the Tools tab, open LUT Manager utility. 

 
2. Create a new LUT file. On the Create LUT dialog box, select the LUT type, set the input and 

output bit depth to 12, and click OK. 
 

 
 
3. Click Customize under the LUT plot. 

 
4. Click More, set Curve type to Dots and Formula to User. 
5. Type in a formula for the new LUT (see  below).  

The following operands and operations are available: 
 
Operation Description  Operator Description 

+ Addition  x x-value 

- Substraction  pi Mathematical constant approximately 
3.1415926535897932 

* Multiplication  

/ Division    

^ Raise to the power of    

cos() Cosine function    

sin() Sine function    

tan() Tangent function    

acos() Arc-Cosine function    

asin() Arc-Sine function    

atan() Arc-Tangent function    

sqrt() Square root    

ln() Log natural    

exp() Exponent    
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6. For a color camera, you can set a transfer function for each channel. Use R, G, and B tabs on 
the left to switch between the channels. 
 

7. To save the LUT file, go to File > Save as…. 
 
 

Example 
 
A modified sigmoid function can be used to enhance low contrast images. The modified sigmoid 
function is given below:  
 

𝐹𝐹(𝑥𝑥) =  
1

1 + 𝑒𝑒−𝑎𝑎(𝑥𝑥−𝑏𝑏) 

 
where x is the input pixel value. 

a is a contrast factor. It determines the steepness of the curve (0.5 – low gain; 10 -high gain). 

b is a threshold level. It determines a sigmoid’s midpoint. A midpoint is the brightness of input 
pixels that is used as a reference. If the brightness of an input pixel is higher than a midpoint, the 
output pixel value is increased. Otherwise, the output pixel value is decreased. 

 
 
In the LUT Manager window, type in the following formula under the Formula control (with a=4 
and b=2): 
 
4095*(1/(1+(exp(-4*(x/(4095/4)-2))))) 
 
The function is scaled so that the input and output pixel values are within the range from 0 to 
4095 (for a 12-bit image). 
 
 

 
 
To adjust the overall brightness and contrast of the image, use both threshold and contrast 
factor parameters. The threshold value controls the amount of brightness, and the contrast 
factor controls the difference between pixels.  

original signal 
sigmoid corrected signal 
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The sigmoid curves with varied threshold and contrast factor parameters are shown below: 
 

 
 
 

 
 
 
To apply a convex part of the curve within the range from 0 to 4095, use the following formula: 
 
2*4095*(1/(1+(exp(-2*(x/(4095/4)))))-0.5) 
 

 

the midpoint is shifted to the 0; 0 position 
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To apply a concave part of the curve within the range from 0 to 4095, use the following formula: 
 
2*4095*(1/(1+(exp(-2*(x/(4095/4)-4))))) 
 

 
 
 
 
 

  

the midpoint is shifted to the 4095; 4095 
position 
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Uploading the LUT File 
After saving the LUT into the .lut file, you can upload it into the camera using the Imperx Upload 
Utility.  

To upload the LUT file: 
1. Connect and power up your camera. 
 
2. Start the Imperx Upload Utility and wait for the Utility to detect the camera.  

If the utility does not detect the camera, click Refresh to restart the device collection. 
 

 
 
Select the camera to update if more than one appears. 
 

 
  

SFP-C6440M-RF000000  1180000 

SFP-C6440M-RF000000  1180000 
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3. Browse for the .lut file, select it, and click Upload.  
Select to which camera’s LUT (LUT1–LUT4) to upload the .lut file you created. 
Wait for the upload to finish. 
 

4. After the upload is completed, do power cycle the camera. 
 
5. After the camera re-starts, start the software GUI and select Data Correction. 
 
6. Set LUTEnable to the LUT you uploaded.  

The camera then uses the LUT you uploaded. 
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